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Copyright   2000, Casady & Greene Inc.

Manual revised March 2000.

This manual and the SoundJam™ MP Plus software are copyrighted by Casady & Greene, Inc. None of the software may be copied 
or modified, in whole or in part, for distribution to or use by others. Information in this document is subject to change without notice. 
Companies, names, and data used in examples herein are fictitious unless otherwise noted.

Please Do Not Make Illegal Copies Of This Software

The software you are using was produced through the blood, sweat, and tears of many people: programmers, writers, editors, project 
managers, artists, distributors, retailers, and other dedicated workers. The costs of developing this and other software programs are 
recovered through software sales. The unauthorized duplication of software raises the cost for all legitimate users.

This software is protected by federal copyright law. Your cooperation in upholding the law will insure continued low-cost upgrades and 
new software. Copying software for any reason other than to make a backup is a violation of federal laws. Individuals who make illegal 
copies of software may be subject to civil and criminal penalties.

Please report all copyright violations to:

Software Publishers Association, 1101 Connecticut Ave., NW, Suite 901, Washington, DC 20036

Limited Warranty

PLEASE READ THIS LICENSE CAREFULLY BEFORE USING THE SOFTWARE. BY USING THE SOFTWARE, YOU ARE AGREE-
ING TO BE BOUND BY THE TERMS OF THIS LICENSE. IF YOU DO NOT AGREE TO THE TERMS OF THIS LICENSE, PROMPTLY 
RETURN THE UNUSED SOFTWARE TO THE PLACE WHERE YOU OBTAINED IT AND YOUR MONEY WILL BE REFUNDED.

1. License. The application, demonstration, system, and other software accompanying this License, whether on disk, in read-only 
memory, or on any other media (the “Software”), and the related documentation and fonts are licensed to you by Casady & Greene. 
You own the disk on which the Software and fonts are recorded but Casady & Greene and/or Casady & Greene’s Licensors retain title 
to the Software, related documentation and fonts. This License allows you to use the software and fonts on a single Apple computer 
and make one copy of the Software and fonts in machine-readable form for backup purposes only. You must reproduce on such copy 
the Casady & Greene copyright notice and any other proprietary legends that were on the original copy of the software and fonts. You 
may also transfer all your license rights in the software and fonts, the backup copy of the software and fonts, the related documenta-
tion, and a copy of this License to another party, provided the other party reads and agrees to accept the terms and conditions of this 
License.

2. Restrictions. The Software contains copyrighted material, trade secrets, and other proprietary material. In order to protect them, 
and except as permitted by applicable legislation, you may not decompose, reverse engineer, disassemble, or otherwise reduce the 
Software to a human-perceivable form. You may not modify, network, rent, lease, loan, distribute, or create derivative works based 
upon the software in whole or in part. You may not electronically transmit the software from one computer to another or over a net-
work.

3. Termination. This License is effective until terminated. You may terminate this License at any time by destroying the Software, 
related documentation and fonts, and all copies thereof. This License will terminate immediately, without notice from Casady & 
Greene, if you fail to comply with any provision of this License. Upon termination, you must destroy the Software, related documenta-
tion and fonts, and all copies thereof.

4. Export Law Assurance. You agree and certify that neither the Software nor any other technical data received from Casady & 
Greene, nor the direct product thereof, will be exported outside the United States except as authorized and as permitted by the laws 
and regulations of the United States. If the Software has been rightfully obtained by you outside of the United States, you agree that 
you will not re-export the Software nor any other technical data received from Casady & Greene, nor the direct product thereof, except 
as permitted by the laws and regulations of the United States and the laws and regulations of the jurisdiction in which you obtained the 
Software.

5. Government End Users. If you are acquiring the software and fonts on behalf of any unit or agency of the United States Govern-
ment, the following provisions apply. The Government agrees:

(i) if the Software and fonts are supplied to the Department of Defense (DoD), the Software and fonts are classified as 
“Commercial Computer Software” and the government is acquiring only “restricted rights” in the Software and its documentation and 
fonts, as that term is defined in clause 252.227-7013(c)(1) of the DFARS; and
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(ii) if the Software and fonts are supplied to any unit or agency of the United States Government other than DoD, the gov-
ernment’s rights in the Software and its documentation and fonts will be as defined in Clause 52.227-19(c)(2) of the FAR or, in the 
case of NASA, in Clause 18–52.227-86(d) of the NASA Supplement to the FAR.

6. Limited Warranty On Media. Casady & Greene warrants the compact disc on which the Software and fonts are recorded to be free 
from defects in materials and workmanship under normal use for a period of ninety (90) days from the date of purchase as evidenced 
by a copy of the receipt. Casady & Greene’s entire liability and your exclusive remedy will be replacement of the compact disc not 
meeting Casady & Greene’s limited warranty and which is returned to Casady & Greene or a Casady & Greene authorized represen-
tative with a copy of the receipt. Casady & Greene will have no responsibility to replace a disc damaged by accident, abuse or misap-
plication. ANY IMPLIED WARRANTIES ON THE COMPACT DISCS, INCLUDING THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, ARE LIMITED IN DURATION TO NINETY (90) DAYS FROM 
THE DATE OF DELIVERY. THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS, AND YOU MAY ALSO HAVE OTHER 
RIGHTS WHICH VARY BY JURISDICTION.

7. Disclaimer of Warranty on Apple Software. You expressly acknowledge and agree that use of the Software and fonts is at your 
sole risk. The Software, related documentation and fonts are provided “AS IS” and without warranty of any kind and Casady & Greene 
and Casady & Greene’s Licensor(s) (for the purposes of provision 7 and 8, Casady & Greene and Casady & Greene’s Licensor[s] 
shall be collectively referred to as “Casady & Greene”) EXPRESSLY DISCLAIM ALL WARRANTIES, EXPRESS OR IMPLIED, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE. CASADY & GREENE DOES NOT WARRANT THAT THE FUNCTIONS CONTAINED IN THE SOFTWARE WILL MEET 
YOUR REQUIREMENTS, OR THAT THE OPERATION OF THE SOFTWARE WILL BE UNINTERRUPTED OR ERROR-FREE, OR 
THAT DEFECTS IN THE SOFTWARE AND THE FONTS WILL BE CORRECTED. FURTHERMORE, CASADY & GREENE DOES 
NOT WARRANT OR MAKE ANY REPRESENTATIONS REGARDING THE USE OR THE RESULTS OF THE USE OF THE SOFT-
WARE AND FONTS OR RELATED DOCUMENTATION IN TERMS OF THEIR CORRECTNESS, ACCURACY, RELIABILITY, OR 
OTHERWISE. NO ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN BY CASADY & GREENE OR A CASADY & GREENE 
AUTHORIZED REPRESENTATIVE SHALL CREATE A WARRANTY OR IN ANY WAY INCREASE THE SCOPE OF THIS WAR-
RANTY. SHOULD THE SOFTWARE PROVE DEFECTIVE, YOU (AND NOT CASADY & GREENE OR A CASADY & GREENE 
AUTHORIZED REPRESENTATIVE) ASSUME THE ENTIRE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION. 
SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES, SO THE ABOVE EXCLUSION MAY NOT 
APPLY TO YOU.

8. Limitation of Liability. UNDER NO CIRCUMSTANCES INCLUDING NEGLIGENCE, SHALL CASADY & GREENE BE LIABLE 
FOR ANY INCIDENTAL, SPECIAL OR CONSEQUENTIAL DAMAGES THAT RESULT FROM THE USE OR INABILITY TO USE THE 
SOFTWARE OR ALTERED DOCUMENTATION, EVEN IF CASADY & GREENE OR A CASADY & GREENE AUTHORIZED REPRE-
SENTATIVE HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. SOME JURISDICTIONS DO NOT ALLOW THE 
LIMITATION OR EXCLUSION OF LIABILITY FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES SO THE ABOVE LIMITATION 
OR EXCLUSION MAY NOT APPLY TO YOU.

In no event shall Casady & Greene’s total liability to you for all damages, losses, and causes of action (whether in contract, tort 
[including negligence] or otherwise) exceed the amount paid by you for the Software, related documentation, and fonts.

9. Controlling Law and Severability. This License shall be governed by and construed in accordance with the laws of the United 
States and the State of California, as applied to agreements entered into and to be performed entirely within California between Cali-
fornia residents. If for any reason a court of competent jurisdiction finds any provision of the License, or portion thereof, to be unen-
forceable, that provision of the License shall be enforced to the maximum extent permissible so as to effect the intent of the parties, 
and the remainder of the License shall continue in full force and effect.

10. Complete Agreement. This License constitutes the entire agreement between the parties with respect to the use of the Software, 
the related documentation and fonts, and supersedes all prior or contemporaneous understandings or agreements, written or oral, 
regarding such subject matter. No amendment to or modification of the License will be binding unless in writing and signed by a duly 
authorized representative of Casady & Greene.

Trademarks

Apple, AppleShare, Apple Remote Access, and Macintosh are registered trademarks, and Balloon Help, Macintosh Drag and Drop, 
System 6, System 7, Mac OS 8, Mac OS 9 are trademarks of Apple Computer, Inc.  MPEG Layer-3 audio compression technology 
licensed by Fraunhofer IIS and THOMSON multimedia. The names of other products and companies appear herein for identification 
purposes only and are trademarks and registered trademarks of their respective holders.
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CHAPTER 1: WELCOME TO SOUNDJAM MP PLUS

Welcome to SoundJam! You now own a powerful music and entertainment program, one that turns 

your Macintosh into the smartest component you ever added to your stereo system. SoundJam makes 

MP3 files sing, dance, and do somersaults at your command.

WHAT’S MP3?
MP3 is a special sound-file format that has become explosively popular on the Internet. You can get 

hundreds of thousands of MP3 files from the Net; this format has enabled great new bands—that you 

otherwise never would have heard of—to get discovered by online fans. Even established musicians—

and their record labels—have jumped onto the MP3 bandwagon; you can often download MP3 pre-

views of your favorite artists’ new songs from the Internet.

The beauty of MP3 files is that they play back songs with amazing quality—to you, they sound almost 

like CDs—but because of the special compression, each MP3 file is only a fraction the size of actual 

CD music files.

Why do you care about how big a sound file is? First, of course, smaller files are faster, less expensive, 

and more manageable to send by e-mail or to post on a Web page. Second, smaller music files mean 

you can fit a lot of them on your hard drive or, say, a Zip disk, turning your Mac into the ultimate 

sound machine. 

Finally, MP3 files are so small, over an hour’s worth of them can fit into the memory of a tiny portable 

MP3 player like Diamond Multimedia’s Rio 500 or Creative Labs’ Nomad II. Load up your favorite 

music from the Mac onto this pocket-sized personal stereo system, and you’ve got skip-proof music in 

your headphones for even the longest morning jogs.

The jukebox has come a long way.

WHAT’S SOUNDJAM?
SoundJam MP is the ultimate MP3 music center. Of course, it can play all kinds of MP3 files, no matter 

where they came from, in any order, with a 10-band graphic equalizer to make the sound quality 

exactly what you crave. But describing SoundJam as just an MP3 player is like describing Leonardo da 

Vinci as just a dead Italian. SoundJam can also:

• Show stunning animated displays that shimmer and dance on the screen in time to the music.

• Change its look at your command—a high-tech control center, a 1950s rock and roll restaurant, a 

prehistoric tablet—thanks to an amazing choice of visual “skins.”
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• Play traditional music CDs with far more control and better visuals than Apple’s built-in CD player 

software.

• Convert almost any kind of sound file, including those on your favorite CDs, into MP3 files that you 

store and manage on your Mac, portable MP3 player, or even your own newly burned CDs. (And of 

course, instead of 70 minutes, a single CD can hold an incredible ten hours of audio as MP3 files! 

Standard CD players can’t play MP3 files, but your Mac can.)

• Download new MP3 files directly from the Internet, thanks to the built-in Web menu.

• Play “streaming” music from the Internet—live broadcasts as well as commercial recordings that 

come in the form of real-time transmissions, not downloadable files.

• Automatically fill in the names of your CDs, songs, and artists, thanks to live links with CDDB, the 

Internet’s massive CD-ROM information database.

• Serve as a database of your own music. Sort by song name, artist name, album, and much more.

• Connect to your stereo with the included patch cord for the ultimate in great sound.

HOW TO INSTALL SOUNDJAM

Installing SoundJam is extremely easy: the SoundJam MP Installer takes care of the process.

1. Insert the SoundJam MP CD-ROM.

The SoundJam CD window will open automatically.

2. Double-click the SoundJam MP 

Installer program. The Installer win-

dow appears, as in Figure 1-1.

3. If you want to install SoundJam on a 

hard disk other than your startup 

disk, click the Switch Disk button in 

the Installer window. Otherwise, 

click the Install button. The Installer 

puts the pieces of the SoundJam 

package into the correct places on 

your hard disk. When the Installer’s 

done, you’ll be prompted to Restart 

your Mac.
Figure 1-1: The Installer window.
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4. When your Mac finishes restarting, there 

will be a folder named SoundJam™ MP 

on the top level of the hard disk you 

chose. Inside the folder, you’ll find your 

new software, as shown in Figure 1-2.

5. Double-click on the SoundJam™ MP 

icon to start the program. 

The first time you run SoundJam, a 

license agreement window appears. 

Read the license (if you like legalese), 

then click the Agree button. Next the 

Personalize dialog box appears, prompting you to type in your name, company (optional), and 

serial number. (You can press the Tab key to jump from one of these blanks to the next.)

❈   Your SoundJam serial number is printed on the front of the CD-ROM envelope and in the front of the man-
ual. Don’t lose this number! If you ever need technical support, you’ll need this number again.

If you’re stranded on a desert island without your serial number, leave the serial number field blank, click 
the OK, button in the Personalize dialog box, and SoundJam will remind you to enter the serial number or 
go into demonstration mode. Click OK, and then click the ”7-Day Demo” button that appears in the Per-
sonalize dialog box. You’ll be allowed to use the software for a week—in demonstration mode, which lim-
its the number of new MP3 files you can create—which should give you time to dig up your serial number.

Figure 1-2: SoundJam and its attendant folders.
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6. Type in your serial number, 

and then click OK.

If your Mac uses virtual mem-

ory—which it almost certainly 

does, since this memory-sav-

ing and speed-enhancing tech-

nology was turned on at the 

factory—a message now 

appears. It lets you know that 

virtual memory may cause 

skipping in the play-back of 

your MP3 files when you do 

something that requires the 

Mac’s full attention, such as 

launching another program. 

For most people, a possible skip in their music won’t be enough of a reason to disable virtual mem-

ory. After reading the message, click OK. The first screen of the SoundJam Setup Assistant opens, as 

shown in Figure 1-3.

7. Read the introductory text and then click the Next button. The Product Registration window 

appears.

In this window, click the radio button next to one of the three registration choices. You can choose 

to register SoundJam now, register later, or tell the Setup Assistant that you have previously regis-

tered SoundJam. Remember that you must register the product in order to receive technical sup-

port from Casady & Greene. Registration also entitles you to some free enhancements to SoundJam 

that are available only to registered users. When you’re done, click the Next button. The informa-

tion window appears.

8. Fill out your name, address, e-mail address, and other information.

You can use the Tab key to move from one information box to the next. Only the name and e-mail 

address is required. Click the Next button when you’re done, and the additional information win-

dow appears.

9. Use the supplied radio buttons to specify which information you want to send and receive from 

Casady & Greene, and feel free to comment about SoundJam in the text box provided. Click the 

Next button.

Figure 1-3: The SoundJam Setup Assistant steps
you through configuring the program.
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10. In the Internet Playback win-

dow, shown in Figure 1-4, tell 

the Setup Assistant if you want 

to use SoundJam as the helper 

application for playing MP3 

files or streams from the Inter-

net. Then click the Finish but-

ton.

That’s all there is to it. The Sound-

Jam folder on your hard drive con-

tains everything you need to start 

playing and making music.

✎    System requirements: With any luck, you made sure that you had the necessary system software and Mac-

intosh model before you bought SoundJam.

For the record, however, you need a Macintosh with at least a PowerPC 603 processor at 100 MHz or 
faster—and Mac OS 7.6.1 or later. Your System Folder requires the extension called Sound Manager 3.2 
(or a later version); unless you threw this software away, it’s already in your Extensions folder.

THE SOUNDJAM TEST DRIVE

Once you’ve installed SoundJam onto your hard drive, using it 

is as easy as using a CD player—easier, in fact. Here’s how:

1. Run SoundJam (if it’s not already open). From SoundJam’s 

File menu, choose Open Playlist, then from the pop-out 

menu, choose Tutorial Playlist, as in Figure 1-5.

A playlist is a list of songs that you’ve arranged in a particu-

lar order. The SoundJam CD comes with more than 100 

music files ready to play—and they’ve been organized into 

the playlist called Tutorial Playlist. That’s the file you’re

Figure 1-4: It’s a good idea to set SoundJam as the
player of choice for Internet MP3 files.

Figure 1-5: Opening the Tutorial Playlist.
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opening for this experiment. (The actual MP3 files themselves are in a folder on the SoundJam CD-

ROM called “Music from songs.com.”)

The SoundJam window is now open. Part of SoundJam’s 

charm is that you can easily change its look; but the first 

time you run the program, it looks like Figure 1-6.

2. Click the Play button (shaped like a triangle), or 

press the Space bar.

SoundJam begins to play the first music file in the 

playlist.

Now you can go to town, using the controls on the 

SoundJam “front panel” to play, stop, jump to previ-

ous track or next track, and so on. Adjust the volume, 

bass, and treble by dragging the sliders at the bottom 

of the window. (You can find details on these con-

trols in the next chapter.) You can even switch to 

another Macintosh program, continuing your work for the day to the soothing strains of 10,000 

Smashing Maniacs (or whoever your favorite happens to be).

But SoundJam isn’t just a treat for your ears—it’s nice to look at, too:

3. From the Window menu, choose Eclipse.

A new window opens, featuring animations of a blazing sun—that dance in time to the music as it 

plays.

4. Click the PL button on the “front panel.”

The Playlist window comes to the front. 

5. Double-click the name of a different track to hear it.

When you’re finished playing around with SoundJam, choose Quit from the File menu.

For even more fun using SoundJam as a music player, turn to the next chapter. You’ll find out how to 

use the Graphic Equalizer, create playlists, hook up your Mac to your stereo for better sound quality, 

and more.

Figure 1-6: SoundJam’s first appearance.
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CHAPTER 2: SOUNDJAM: THE E-JUKEBOX

SoundJam can create music files, organize them, download them, annotate them, and much more. 

What you’ll do most of the time with SoundJam, however, is play music files.

And where, you may ask, do these files come from? The world is filled with them. SoundJam can play 

not only standard audio CDs and MP3 files, but also QuickTime audio, AIFF, WAV, and other sound 

formats. See the next chapter for instructions on getting music files from the Internet, the SoundJam 

CD, or even your own CD collection. Use this chapter, meanwhile, as your guide to playing the files 

you collect.

HOW TO OPEN A MUSIC FILE

Once you’ve managed to acquire a music file, you can open it in SoundJam in any of these ways:

• If the sound file is one you’ve previously opened or created with SoundJam, just double-click it.

• Drag the music file icon onto the SoundJam icon (see Figure 2-1).

• Launch SoundJam. From the File menu, choose Open. Navigate to the folder where you keep your 

music files, and double-click to open one.

• Launch SoundJam. Drag music file icons from your desktop directly on top of any SoundJam win-

dow, also as shown in Figure 2-1. You can even drag an entire folder of sound files into a SoundJam 

window

Figure 2-1: Open a sound file by dragging its icon onto the SoundJam icon
(left), or by dragging its icon into any SoundJam window (right).
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✎    SoundJam can also serve as the front panel for your regular music CDs, replacing the much more limited 

Apple AudioCD Player program in your Apple menu. Just insert a music CD while SoundJam is running; 
the SoundJam Playlist window appears automatically, listing the tracks on the disc.

THE PLAYER WINDOW

The Player window is the “front panel” of your virtual 

music player. It contains a volume slider, play and stop 

buttons, a counter, and so on. The exact controls visible 

on this important window vary, depending on the skin or 

graphic design module you’re using at the moment (see 

Switching Skins, later in this chapter); in general, however, 

you’ll find the following elements, as shown in Figure 2-2:

A. Close box—Click this button to close all the windows 

and quit SoundJam.

B. Song information—Clicking in this area cycles between the current song’s title, the album name, 

and the name of the artist. If the song is being “streamed”—sent to you over the Internet—Sound-

Jam shows you part of the URL of the song.

If you don’t see the actual song names displayed here, and instead you see just “Track 02,” for 

example, it’s probably because you’re playing an audio CD that SoundJam doesn’t recognize. For-

tunately, the program links to CDDB, the world’s largest CD track-name database, which means 

that you can have this information filled in automatically with a single connection to the Internet. 

See the next chapter for details.

C. Position bar—As your sound file plays, the handle on the position bar inches to the right. When-

ever you want to hear a particularly great musical moment again, grab the position handle with 

your mouse, drag it to the left, and release, thus making SoundJam repeat the juicy moment as it 

plays back. On the other hand, if you know that a particular verse of the song, one that you can’t 

stand, is coming up, you can grab the position handle and drag it to the right, past the offending 

moment.

You can also click anywhere in the position bar to jump to the corresponding spot in the track 

(instead of dragging the handle on the position bar).

D. Equalizer button—Click this button, often marked by the letters E or EQ, to open the Graphic 

Equalizer window, described in the next section.

Figure 2-2: The Player window.
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E. Playlist button—Click this button, usually marked by the letters P or PL, to open the Playlist win-

dow. In this window, you see the list of songs SoundJam is ready to play—either because it’s the 

table of contents of the current CD, or because it’s the list of MP3 or other audio files you’ve assem-

bled yourself. See “The Playlist Window,” later in this chapter.

✎    Tip: You can highlight a particular track in the playlist by typing the first few letters of its name.

F. Min/Max box—If the SoundJam Player window is taking up too much room on your screen, click 

this button. The Player window “collapses,” hiding many of the less important controls, so that it 

takes up less room on your screen.

G. Counter—As on a real CD player, this counter shows the current elapsed-time location of the track 

you’re playing. Depending on the “skin” module you’re using (see “Switching Skins,” later in this 

chapter), the display may show minutes:seconds, hours:minutes:seconds, and so on.

✎    Tip: When you click the counter display, it changes to display the remaining time left to play the current 

track. Clicking again displays the total time of the track.

H. Bass and Treble sliders—These sliders correspond to the Bass and Treble knobs on a standard ste-

reo component. If your music sounds too tinny, boost the bass (by dragging its slider to the right); 

if there’s a hiss, you might want to decrease the treble (by dragging its slider to the left). You can 

also set a new bass or treble level by clicking anywhere in the sliders’ “tracks.”

✎    Note: Whenever you adjust the bass and treble sliders, you automatically deactivate SoundJam’s Graphic 

Equalizer, described below; after all, both sets of sliders affect the same qualities of the music. (To reacti-
vate the graphic equalizer, click the Active or On button on the equalizer window itself.)

I. Repeat button—As you repeatedly click this button, its appearance changes. When you see the 

button label change to “Repeat 1" or “Rep. 1,” SoundJam will play the current song over and over 

again (until you quit the program, play a different song, or turn off the Repeat button).

Click the Repeat button a second time, and the button now just says “Repeat ∞,” “Repeat All,” or 

“Rep.” Now the entire playlist plays over and over again, endlessly looping. (If you’re in Shuffle 

mode, the Repeat button makes SoundJam begin a new, complete play of the playlist, in a new ran-

dom order.)
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Click the Repeat button a third time to make the “light” go out, indicating that SoundJam won’t 

repeat anything at all.

❈   Alert: The look, wording, and behavior of the Repeat button depends on the “skin” you’re using at the 
moment. Some may not, for example, include a Repeat 1 function. See “Switching Skins,” later in this 
chapter.

J. Shuffle button—Click this button to make it “light up,” indicating that SoundJam will play the 

songs on the current CD or playlist in a random order. Click it again to make the “light” go out, 

which means that SoundJam will play the songs from beginning to end in their original order.

If you click Shuffle while a song is playing, SoundJam continues playing the same song—but treats 

it as Song #1 of a newly shuffled playlist. You’ll hear the entire playlist again, beginning with the 

song in progress.

K. Graphic spectrum display—This graphic display indicates the frequency spectrum (the high-low, 

or frequency, range) of the song you’re listening to. The broader the spectrum, the better the 

recording. The graph dances in time to the music. Click on the graphic display to change the look 

of the display from three variations of a frequency spectrum analyzer graph to an oscilliscope-like 

presentation. A final click turns the graphic display off. 

L. Readout—SoundJam’s display may also show you the current song’s sample rate in kHz (kilohertz), 

bit rate in kbps (kilobits per second), and whether it is playing in mono or stereo. These technical 

parameters are described in Chapter 4; in essence, though, they provide an indication of the 

recording quality. (A music CD is generally recorded at 44.1 kHz and 1411 kbps.) 

M. Balance control—If you’re listening to your music in stereo, use this slider to adjust the relative 

balance between the left and right speakers or headphones. (SoundJam can also swap the two 

channels, left-for-right; see “Preferences” in Chapter 5.)

N. Play and Stop buttons—Click the Play button (usually marked with a triangle), or press the Space 

bar, to begin playback; click the Stop button (usually marked with a square), or press Command-

period, to stop the music and rewind to the beginning of the track.

O. Volume slider—Drag this slider, or press Command-up arrow/Command-down arrow, to make 

the music louder or softer.

P. Eject button—This button, which is operational only when there’s a CD in your Mac, ejects the disc 

and removes it from the Finder’s desktop. If you prefer, you can instead press Command-E. 
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Q. Pause button—Click this button, or press the Space bar, to stop the music in its tracks; when you 

click Play again, the music picks up from where it left off. (The Pause button doesn’t work when 

you’re playing streaming audio from the Internet, as described in the next chapter.) 

R. Fast Forward button—Click this button, or press the right-arrow key on your keyboard, to skip to 

the next song in your playlist. Holding this button down shifts SoundJam into fast forward for the 

current track, and the longer you hold down the button, the faster SoundJam will skip ahead.

✎    Tip: You can press the right-arrow key on your keyboard as an alternative to clicking the onscreen Fast For-

ward button. Holding down Command-Option and the right-arrow key puts SoundJam into a fast forward 
mode within the currently playing track.

S. Rewind button—If you click this button within the first three seconds of a track’s playback, Sound-

Jam plays the previous track in the current playlist. Pressing it repeatedly is a great way to hunt for 

a certain song: just click the button—listen for a moment—click the button again, and so on.

If you click the button after the first three seconds, on the other hand, SoundJam starts playing the 

current track from the beginning. Holding this button down puts SoundJam into rewind for the 

current track, and the longer you hold down the button, the faster SoundJam will backtrack.

✎    Tip: You can press the left-arrow key on your keyboard as an alternative to clicking the onscreen Rewind 

button. Holding down Command-Option and the left arrow key puts SoundJam into fast rewind.

T. Options button (not pictured)—Only some “skins” offer this button, whose label often says OP; it 

opens the SoundJam Preferences window, described in Chapter 5.

U. Stereo/Mono Indicator—This icon tells you if the currently playing track is stereo or mono.

V. MP3, CD, Net Indicators (not pictured)—These indicators are only available with some custom 

“skins.” They tell you that the playback source is a local MP3 file, a CD inserted in your machine, or 

streaming to you over the Internet.

W. Animations (not pictured)—This new feature (as of SoundJam 1.7 and later) allows some custom 

“skins” the capability of animating during playback. If you have one of these animating “skins,” 

you’ll see SoundJam get down and dance while the music plays! 
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GRAPHIC EQUALIZER

The Graphic Equalizer is a tantalizing SoundJam feature. 

Using its 10 sliders, corresponding to 10 different fre-

quency ranges in the music you’re listening to, you can 

tailor the bass, treble, midrange, and other qualities of the 

music to suit your speaker system and your tastes. Think 

of the Graphic Equalizer as the same hi-fi controls you’d 

pay $2,000 extra for on the real CD player—yours free with 

SoundJam.

To open the Graphic Equalizer window, choose its name from the Window menu—or click the EQ but-

ton, if there is one, on the Player window. Either way, a window like the one shown in Figure 2-3 

appears. Here’s how you use it:

A. Close box—Click this square to hide the Equalizer window. You can always make it reappear by 

choosing its name from the Window menu.

B. On/Off—The Graphic Equalizer sliders work only when this button is engaged, lit up, or turned on. 

(When you’re using the “skin” that first appears when you launch SoundJam, the button says On, 

when it is On.)

Click to turn off the equalizer (without disturbing the slider positions)—a handy feature when 

you’re trying to “A/B” the music, alternately listening to it with and without the effects of equaliza-

tion. You may have to wait a second or two before you can hear the difference.

The Equalizer is automatically turned off whenever you adjust the Bass and Treble sliders 

described earlier in this chapter. The Equalizer’s effects are also ignored if you turn off “Use CD 

Digital Audio Playback” in SoundJam’s Preferences screen, as described in Chapter 6.

✎    Note: Turning off the Equalizer is a good idea if you’re trying to run speed-intensive programs on your 

Mac; SoundJam may slow down computations in other applications while the Graphic Equalizer is in use.

C. Equalizer bands—Drag these sliders to shape the sound of SoundJam’s music playback. If you’re 

playing through tinny PowerBook speakers, for example, you might want to boost the bass (drag 

the leftmost sliders upward) and tone down the treble (drag the rightmost sliders downward). If 

you’re listening to the music through especially boomy headphones, you might want to decrease 

the bass slightly.

Figure 2-3: Use the Graphic Equalizer to
shape the sonic qualities of your music.
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It may take a second or two before you hear any difference after adjusting a slider. Also, keep in 

mind that SoundJam’s sliders are more sensitive than those on your stereo equipment; small 

adjustments have more impact.

D. EQ Presets pop-up menu—SoundJam comes equipped with a number of memorized, pre-

adjusted slider settings. From this icon/pop-up menu, choose (for example) Classical, Vocal, or 

Rock to adjust all the sliders at once to make the corresponding kind of music sound especially 

good.

Similarly, if you’ve tweaked the sliders to absolute perfection for your particular Mac, tastes, and 

music collection, you can save the sliders’ positions for future use. From this pop-up menu, choose 

Save Settings. When the standard Save File dialog box appears, if you’re not already looking at the 

contents of SoundJam’s Equalizer Presets folder, navigate to it (click Desktop, open your hard drive, 

open the SoundJam folder, and open the Equalizer presets folder). Type a name for your presets 

(“External iMac Speakers,” for example) and then click Save (or press Return). From now on, your 

saved preset will also appear in this pop-up menu. 

✎    Tip: To delete a presets file, open your hard drive, open the SoundJam folder, and then open the Equalizer 

Presets folder. There you’ll find icons representing each item in the Presets pop-up menu; throw away the 
one you don’t want. Next time you run SoundJam, that preset no longer appears in the pop-up menu.

E. Reset—Click this button to make all the sliders snap back to their original “zeroed” positions.

F. Preamp—This slider changes the overall volume of the currently playing track. (Behind the scenes, 

it adjusts the level of all the Equalizer sliders at once, although you’ll notice only a sonic, not visual, 

difference.)

The Preamp slider can be useful when listening to a track that was recorded especially quietly, for 

example. Be careful, however: If you drag this slider too high, you’ll pump too much sound through 

your Mac’s sound circuitry; the result is the unpleasant, rattling distortion sound that comes from 

over-cranking an amplifier (or your Mac’s speaker). Of course, a quicker way to avoid clipping is to 

click Auto, described next.

G. Auto—This button is your weapon against clipping, described in the previous paragraph. When 

Auto is turned on, lit up, or shown in white lettering, SoundJam automatically lowers the volume, if 

necessary, enough to avoid this clipping effect. (Your slider positions don’t change.)
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THE PLAYLIST/CDWINDOW 
The Playlist window is a list of the 

tracks you’ve chosen to play—and 

a cheat sheet that displays their 

order. The CD window, which 

appears when you insert a music 

CD, is almost identical. 

To open the Playlist window, 

choose its name from the Window 

menu. To open the CD window, 

simply insert a CD. Either way, a 

window like the one shown in Fig-

ure 2-4 appears. You can create and save playlists of your own, of course; see Chapter 3. In the mean-

time, SoundJam uses a built-in one called the Master Playlist. At the top of the Master Playlist (or any 

Playlist), SoundJam tells you how many items you have in the Playlist, the total playing time of those 

items, and how much disk space they take up.

SoundJam can display up to ten different columns of information about the files in your playlist. You 

can control whether the lists are sorted from A to Z or from Z to A, adjust the widths of the columns, 

and add or remove columns as your whim suits you. 

WHERE SOUNDJAM GETS ITS INFO

When you first insert a music CD, the Playlist columns probably don’t show much useful information. 

SoundJam can fill in the blanks for you—artist and album name, song names, and so on—when you 

use the Web Database feature, which is described in the next chapter. 

When you load up a playlist with sound files, such as MP3 files, however, it’s a different story. Album, 

Artist, Genre, and other such information is often embedded directly in your MP3 files.

✎    Tip: If some of your MP3 files didn’t come with embedded identifying information, you can record such 

information manually. Highlight a music file in the Playlist; from the File menu, choose Get Info. In the 
resulting Track Information window, you’ll be offered the chance to type in this kind of data for the high-
lighted file. You can even add or change information for a group of files in one fell swoop. See Chapter 3 
for more on this.

Figure 2-4: You can drag files up or down in
the Playlist to change their playback order.
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SOUNDJAM’S PLAYLIST COLUMN CRITERIA

The Playlist column with the most possibilities is the leftmost one. This is the column that shows your 

files’ names. Using the “Listed by” pop-up menu above the list, you can sort these files in any of the 

following ways:

• by Album—Your files are grouped in clusters according to the CD they came from (if SoundJam 

knows this information).

• by Artist—Your files are grouped in clusters according to the band or singer’s name.

• by Bit Rate—This is a way to group your files according to recording quality. CD files are higher 

quality than MP3 files, so this is an easy way to sort your playlist and see which files still need to be 

converted to MP3. If you converted some MP3 files at a lower bit rate (to trade audio fidelity for file 

size), you can spot your lower fidelity files.

• by Date—This option lets you see your tracks in chronological order. (The date that appears here 

depends on the kind of files you’re viewing; MP3 files, for example, are listed here by their most 

recent modification dates. A music CD may show today’s date.)

• by Genre—If your music files contain self-identifying Genre information (such as Classical, Pop, or 

R&B), you’ll see it displayed here.

• by Kind—SoundJam plays MP3, CD, streaming MP3, MP2, and Macintosh “snd” files, This column 

sorts by file type.

• by Name—SoundJam sorts the list alphabetically by the tracks’ names.

• by Conversion Order—This command, available only in the Converter window, will display the 

order in which files will be converted.

• by Play Order—This view shows your files in the order they’ll be played. 

✎    Tip: The Play Order view is especially useful: it’s the only listing that lets you drag the songs up or down 

for manual control over their playback order, as shown in Figure 2-4.

• by Shuffle Order—When you’ve asked SoundJam to play the tracks in your playlist in a random 

order, this view lets you know what the mixed-up order will be.

• by Size—When you choose this command, SoundJam lists the files in the playlist according to their 

file size on your hard drive (or the CD you’ve inserted).
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• by Time—This listing groups your files according to the playing times of the tracks.

• Copy to Play Order—This menu choice takes the currently selected playlist display order and 

makes it the playing order for your songs.

• Reset Play Order—This command, available only in a CD window, will change the play order back 

to the original play order for a CD.

✎    Tip: SoundJam sorts your sound files 

with (for example) the longest, most 
recent, or alphabetically earliest 
files at the top of the list. But you 
can reverse the sorting order, 
regardless of the criterion you’ve 
chosen for listing—just click the 
tiny pyramid-shaped button in the 
upper-right corner of the file list, 
shown in Figure 2-5. (Click that tiny 
button again to restore the initial 
sorting order.)

In the Album, Artist, Genre, and 

Kind views of your information, 

SoundJam shows the files hierar-

chically, similarly to list views in 

the Finder. This is especially useful 

in the Artist view, which shows a 

folder for each artist, and inside 

that folder, additional folders for 

their albums, shown in Figure 2-6. 

Click on the disclosure triangles to 

expand the list view as needed.

Figure 2-5: Click to (a) change the info criterion,
(b) adjust the column widths,

(c) add or delete columns, or
(d) reverse the sorting order.

Figure 2-6: Viewing a playlist by Artist
shows all their albums, too.
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✎    Tip: Option-clicking on a folder in a playlist opens or closes all of the folders (and if they exist, subfolders)  

in that view.

MANAGING THE OTHER COLUMNS

When you first install it, SoundJam shows you four different information columns, as shown in Figure 

2-5. But you can add more columns, if your curiosity demands it, simply by clicking the tiny plus sign 

at the upper-right corner of the window. (Click the tiny minus sign, conversely, to decrease the num-

ber of visible columns, starting from the right side.)

✎    Tip: You can resize the playlist or CD window to accommodate longer track, artist, or album names by 

dragging the resize box at the lower-right corner.

But even if you don’t have a gigantic monitor, you can still enjoy multiple columns—just make them 

narrower to fit your screen. To adjust the widths of your columns, horizontally drag the divider line 

between the pop-up menus atop each column, as shown in Figure 2-5.

As with the first column, the additional columns you add can also show almost any information you 

like about your files. The commands here are much the same as those listed in the first column, but 

there are some additions:

• Location—This gives you the actual file name of the song, as shown in the Finder. This may be dif-

ferent from the Name of the song in the first column of the playlist.

• Sample Rate—Like Bit Rate, this is another setting that affects the fidelity of the sound file. See 

Chapter 4 for a detailed explanation.

• Track—If you converted the MP3 file from a CD, this tells the CD track number.

• Year—The year the song was recorded, if SoundJam knows it.

CONNECTING YOUR MAC TO YOUR STEREO

You can listen to your music files using four kinds of equipment: your computer’s built-in speakers; 

special computer speakers you’ve attached to your Mac’s sound-output jack (on the back panel); 

headphones (again connected to the back panel sound-output jack); or your stereo. If your Mac is 

close enough to your stereo system, you can use the patch cord included in the SoundJam package to 

hook your computer up to your receiver—for maximum sound quality. (The cable is not, of course, 
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included with copies of SoundJam you download from the Internet; today’s modem technology is too 

slow for the transmission of physical objects.)

To do so, plug the thinner end of the cord (a miniplug) into the Sound Output jack on the back of your 

Mac, whose icon looks like a speaker emitting sound waves. Plug the fatter ends of the cord (RCA 

jacks) into the right and left auxiliary inputs of your stereo receiver; the red cable goes into the right 

channel. 

Turn the volume knob of your stereo almost all the way down. The front panel of your receiver proba-

bly includes an input-selection knob that lists CD, Tape, Aux, and so on; turn it so that it matches the 

jacks you used on the back of it (probably Aux). 

Start the music playing in SoundJam; turn up your stereo’s volume knob until the music is playing at 

the level you like.

SING ALONG WITH SOUNDJAM: KARAOKE MODE

For many of us, singing along with our music is a real joy. Depending on the quality of our singing 

voices, it may or may not be as pleasant for our family and co-workers! But regardless of your vocal 

talents, SoundJam makes it easy to serenade those around you with its special karaoke mode. When 

karaoke mode is switched on, SoundJam does an amazing thing: it digitally processes the music in an 

attempt to remove the main vocalist. And, most of the time, it does a pretty good job. With karaoke 

mode on, the singer’s voice in most popular music fades into the background, clearing the way for 

your star turn. Because there’s no free lunch (even in the digital realm), the price you pay for this vocal 

excision is an overall lowering of sound volume and, sometimes, a reduction in musical fidelity. The 

main thing that affects how much the music will be changed by the digital karaoke processing is the 

way the original track was recorded; there’s no hard and fast rule. Just try it, and sing out!

To activate karaoke mode, choose Karaoke from SoundJam’s Controls menu, or press Command-K on 

your keyboard. Choose the command again to toggle Karaoke mode off.

✎    Note: Karaoke is a Japanese abbreviated compound word, invented (like karaoke itself) in the 1980’s: 

“kara” comes from “karappo” meaning empty, and “oke” is the abbreviation of “okesutura,” or orchestra. 
Usually, a recorded popular song consists of vocals and accompaniment. Music tapes in which only the 
accompaniment is recorded were named “karaoke.” 
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USING SOUNDJAM AS AN ALARM CLOCK OR A SLEEP TIMER

If you keep your Mac close by your bed (or hook your 

Mac up to your sound system), you can use SoundJam 

to lull you to sleep or to wake you up in the morning at 

a time you choose. You can pick the playlist you want 

to use, so if you’re an especially heavy sleeper, that 

playlist filled with Sousa marches should be just the 

ticket.

To set up SoundJam’s timed playback features, choose 

Alarm Clock/Sleep Timer from the Window menu, or 

press Command-5. The Alarm Clock/Sleep Timer win-

dow opens, as shown in Figure 2-7.

To set the time SoundJam wakes you up, click the 

Wake checkbox, pick a day of the week, every day, 

weekdays, or weekends from the pop-up menu, then 

type in the time you want to be awakened. Be sure to 

add AM or PM. Then click the “Select Alarm Action File” button to choose a playlist, audio file, or 

AppleScript to trigger when the alarm goes off. If you don’t choose anything here, SoundJam will play 

the current track.

✎    Tip: SoundJam does not have to be open for the alarm to work. If you have the SoundJam extension in your 

System Folder and it is active (using Extensions Manager or Conflict Catcher), the SoundJam application 
will launch when the alarm activates.

If you want to use SoundJam as a sleep timer (in which case it will play music for a specified time 

while you fall asleep, then turn itself off), first set the timer delay in minutes, then pick what you want 

to occur when the timer expires. Your choices are to stop playing, quit SoundJam, put your Macintosh 

to sleep, or Shut Down your Mac. Begin the sleep timer’s countdown by clicking the Start Timer but-

ton. 

Figure 2-7: SoundJam can be an
alarm clock or a sleep timer.
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EYE CANDY: SOUNDJAM’S VISUAL PLUG-INS

SoundJam isn’t just a music player; it’s also a treat for the eye, thanks to its Plug-ins and Skins, 

described in this section and the next. 

Plug-ins are small, add-on software modules that add a visual (and sometimes aural) component to 

the music playback. 

OPENING A VISUAL DISPLAY

Try this:

1. Start some music playing.

2. From the bottom half of the Window menu, choose the name of the visual plug-in you want to use. 

A window opens, showing live, animated, visual displays that pulse in time to the music. The plug-

ins included with SoundJam are purely visual displays, but future plug-ins may even affect the 

sound, too—adding reverb, for example. 

✎    Tip; Depending on the plug-in, you may be able to click inside the window to experiment with options in 

the pop-up menu that appears.

ADDING PLUG-INS

Now that SoundJam has become an enormous smash-hit best-seller, independent artists and pro-

grammers have developed their own, additional plug-ins. They are posted at www.SoundJam.com. 

Once you’ve downloaded them, you can install them into SoundJam’s Window menu like this:

1. Drag the plug-in file into the Plug-ins folder, which is inside the SoundJam folder on your hard 

drive. Depending on the type of plug-in you’re adding, you’ll want to drag it into the Audio Plug-

ins, Device Plug-ins, or Visual Plug-ins folders inside the main Plug-ins folder.

2. Launch SoundJam. The new plug-in appears as a new command in the Window menu.

✎    Tip: Press Command-F to expand a visual plug-in so that the window fills your entire screen—a great effect 

at parties. 
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This feature works only, however, if you install the system extension called DrawSprocketLib, which is 

in the SoundJam folder, in a folder called, “DrawSprocket 1.1.4.” Install DrawSprocketsLib by dragging 

it onto your System Folder icon; you do not need to restart your Macintosh after installing this file.

SWITCHING SKINS

A skin is a graphic-design scheme—a “look.” The ability to give your music player a space-age look, a 

1950s look, or any other look is a hallmark of the best MP3 players, and SoundJam is no exception.

CHOOSING A SKIN

From the Skin 

menu, choose a 

skin. You may not 

know what to expect 

as you choose each 

command, but 

you’ll find out soon 

enough what visual 

surprise lurks 

behind each name. 

A few of the differ-

ent looks are shown 

in Figure 2-8.

✎    Tip: Variety is the spice of life. By choosing Random from the Skins menu, SoundJam will use a different 

skin every time you run the program.

You’ll notice, by the way, that not every design scheme includes all of the different playback controls 

described at the beginning of this chapter. For simplicity, a skin designer may have omitted certain 

controls; some of the skins lack a coordinated design for the Graphic Equalizer, for example.

Figure 2-8: Different looks for different moods.
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Because skins are created by different artists all over the Internet, you may have to spend some time 

experimenting before discovering which control in a particular skin is the volume control, which is 

the balance adjustment, and so on. 

DOWNLOADING AND CONVERTING NEW SKINS

SoundJam comes with numerous skins, resembling everything from a prehistoric cave painting to a 

psychedelic swirl. You can find dozens of additional skins on the Internet; use the Get Skins command 

in SoundJam’s Web menu to jump to the skins download page on www.SoundJam.com.

You’re not limited to skins designed specifically for SoundJam; most of the Internet’s skin collection is 

intended for use by Windows-based MP3 playing programs, such as the popular WinAmp. There’s also 

another Mac MP3 player called Audion which has a nice collection of skins. Fortunately, SoundJam 

includes a conversion program that automatically turns downloaded WinAmp skins and Audion faces 

into SoundJam-compatible ones. To do so, follow these steps:

1. Open the SoundJam folder. 

Inside is a program called Skin Converter.

2. Drag the folder containing the WinAmp skin pieces onto Skin Converter. Or drag the Audion Face 

file onto Skin Converter.

Instantly, your downloaded skin file is readied for use with SoundJam and placed in the Skins 

folder, which is also in the SoundJam folder. 

3. In SoundJam, open the Skin menu. 

Without even having to quit and relaunch SoundJam, you see your newly converted skin file in the 

Skins menu. Pick a skin, and SoundJam’s appearance changes.
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CHAPTER 3: 
BUILDING AND ORGANIZING YOUR MUSIC COLLECTION

Chapter 2 covered SoundJam’s skills as an electronic jukebox. The program is equally adept, however, 

at helping you acquire and organize your music. 

WHERE TO GET MUSIC

The world has gone MP3-crazy: MP3 files are the most popular music-file format on the Internet. But 

no matter where your music files come from, SoundJam is ready to help you organize, search, and 

play them.

FROM THE SOUNDJAM CD
Your SoundJam CD-ROM comes with 100+ MP3s, ready-to-play music files. (You’ll find them in the 

“Music from songs.com” folder.)

To play one using SoundJam, double-click its icon; it opens in SoundJam and begins playing automat-

ically.

If you prefer, double-click instead the Tutorial Playlist icon inside the Playlists folder, which is inside 

the SoundJam folder on your hard disk. The Tutorial Playlist contains all 100+ songs, so that your Mac 

can serve as a jukebox with only a double-click. See Chapter 2 for details on playing back these files.

FROM THE INTERNET BY DOWNLOADING

Hundreds of Web sites offer MP3 files ready to download and play. Try, for example, www.mp3.com, 

one of the most complete MP3 collections. (Many files found here are free; others require you to pay a 

fee.) 

✎    Tip: Use SoundJam’s Web menu as a shortcut for jumping to some of the best MP3 sites. 

FROM THE INTERNET BY STREAMING

Some MP3 files aren’t available for download, but only for streaming. In this scenario, the music data 

is sent by the Web site directly into SoundJam for real-time playback; you never download a file, and 

you can listen to the music only when you’re actually connected to the Net. A record company might 

post a streaming MP3 file, for example, so that you can listen to a track of a new CD—without being 

able to easily capture or distribute it.
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For example, Figure 3-1 shows the Play buttons on one 

of the largest MP3 Web sites, www.mp3.com. Play 

means “send as streaming audio”; when you click this 

button, the MP3.com site (and some others) give you 

the option of two quality settings, depending on the 

speed of your Internet connection. The slower speed is 

appropriate if you have a modem connection, and the 

higher speed (which also offers higher quality) setting 

is best if you have a fast connection, such as DSL, 

ISDN, or a cable modem. Whichever speed choice you 

make, SoundJam launches and begins playing the 

music as it’s fed to your Mac from the Internet. (Sound-

Jam can also play streaming QuickTime music files, 

another popular streaming audio format, if you have QuickTime 4.0 or later installed on your Mac.)

✎    Tip: SoundJam automatically plays streaming audio only if, the first time you launched it, you authorized 

SoundJam as your preferred streaming-audio application. If you declined at that time, you can designate 
SoundJam once again to be the program you want to play your streaming audio by following these steps:

From the Edit menu, choose Pref-

erences. Click the General icon; 

click the button called Use Sound-

Jam for Internet Playback, as 

shown in Figure 3-2. Click OK. 

From now on, whenever your 

Macintosh begins to receive a 

stream of music information from 

a Web site, SoundJam automati-

cally opens and plays it. 

FROM YOUR OWN 
MUSIC CD DISCS

SoundJam is a superior player for 

music CDs—far better than the 

AppleCD Audio Player. Just insert 

a music CD into your Mac and hit 

the Play button. If you choose the 

name of the CD (or the words “Audio CD”) from the Window menu, moreover, a list of the tracks on 

Figure 3-1: On some Web sites, streaming
music is labeled, for example, Play.

Figure 3-2: Tell your Web browser to use SoundJam to play streaming
MP3 files by clicking the Use SoundJam for Internet Playback button.
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the CD appears (see Figure 3-3); you can manipulate this list exactly as you would any SoundJam play-

list, as described in Chapter 2. 

If you want SoundJam to automatically begin playback whenever you insert a music CD, open the 

General panel of SoundJam’s Preferences. From the pop-up menu next to “On CD Insert,” choose 

“Begin Playing.”

FROM YOUR OWN MUSIC CD FILES

One of SoundJam’s most useful features is its ability to turn your favorite CD tracks into compact MP3 

files that you store on your hard drive. Because MP3 files take up only a fraction of the disk space 

required by an actual CD track, you can conveniently build a collection of MP3 files—converted from 

your favorite discs—that you keep stored on, and play back from, your hard drive. For instructions on 

performing this kind of CD-to-MP3 conversion, see Chapter 4.

FROM PRACTICALLY ANY OTHER SOUND FILE

SoundJam plays a wide variety of sound file formats. Besides CD audio and MP3 files, you can play 

QuickTime sound files, and older sound formats such as AIFF, WAVE, “snd,” MOD, and MP2 files. You 

can also convert any file SoundJam can play into an MP3, MP2, or AIFF file.

FROM ANY AUDIO SOURCE YOUR MACINTOSH CAN USE

With SoundJam’s Record From Sound Input feature, you can create a digital file from any audio input 

that your Mac has, whether it be an external microphone, an expansion card with audio input capa-

bilities, or the audio-in features of some AV-enabled Power Macintoshes, such as the Power Macintosh 

8600. SoundJam uses the audio input source that you set in the Sound control panel (in some versions 

of the Mac OS, you determine audio settings in the Monitors and Sound control panel).
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One of the most exciting uses for the Record From 

Sound Input feature is the ability (with the right audio 

input hardware) to record and convert old vinyl 

records or cassette tapes into a digital format. You’ll 

need audio hardware that can accept line-level audio 

from a turntable or tape deck; a preamplifier or a 

mixer connected to any Mac’s audio input jack will 

do, or some Macs come factory equipped with stereo 

RCA jacks.

In order to record sound from one of these audio 

inputs, make sure that the input source is selected in 

the Mac OS Sound control panel, then choose Record 

From Sound Input from SoundJam’s File menu. You’ll 

be asked to name the file that you’re about to record; 

enter a name and click the Save button. SoundJam 

then opens a Sound In window, as shown in Figure 3-3.

✎    Tip: If you have problems getting your Macintosh to change the sound input source, make sure to quit all 

open applications and try again.

Using the Input Gain slider, set the sound levels so that the highest peaks of the sound don’t make the 

Levels display turn red and you can’t hear any audible distortion. When the input levels are correct, 

click the Start Recording button. While the recording is taking place, the Status area of the window lets 

you know the elapsed recording time. Click the Done Recording button when you’re finished. Sound-

Jam then opens a Track Information window that lets you enter in any of the standard MP3 informa-

tion, such as title, artist, or comments. The recorded track is then added to your Master Play-list (or 

whatever playlist is set in the Advanced preference panel) for easy manipulation.

ORGANIZING YOUR MUSIC COLLECTION

Once you’ve amassed your music collection, you can use SoundJam as the ultimate multi-disc 

changer. The program can organize your music any way you see fit, so that you can leave out the songs 

you don’t like, play your favorites at the beginning, and so on.

THE IDEA BEHIND PLAYLISTS

In the previous chapter, you can read about playlists, SoundJam’s music-organization windows. In 

each playlist file, you can arrange music files any way you like. You might create multiple playlists for 

Figure 3-3: When you record from sound input,
you can adjust the input levels for best results.



CHAPTER 3: BUILDING AND ORGANIZING YOUR MUSIC COLLECTION 27
different occasions: one that contains nothing but party tunes, another filled with soothing New Age 

music to play while you write, and so on. Because playlists are so versatile and easy to create, you can 

build playlists for as general or specific a reason as you desire. With SoundJam’s Playlist Composer 

(detailed below), you can even have SoundJam build playlists for you.

WORKING WITH PLAYLISTS

To create a new playlist, choose New Playlist from the File menu. A new, empty playlist window 

appears; load it up with music, fiddle with its columns, and sort the tunes, as described in the previ-

ous chapter. From the File menu, choose Save to give your new playlist a name and file it away on your 

Macintosh.

✎    Tip: You can organize your playlist files just as you’d organize any Macintosh files: by putting them into 

folders on your desktop, for example.

Better yet, store them in the Playlists folder, which is inside the SoundJam folder. Put an alias of the 

Playlists folder into the Apple Menu Items folder, which is inside your System Folder. When you do so, 

all of your playlists become extremely easy to open—simply choose their names from the Playlists 

command that now appears in your Apple menu. If you’re in SoundJam, you have equally quick access 

to playlists; just choose the playlist you want from the hierarchical menu under the Open Playlist 

command in the File menu. To add a playlist to this hierarchical menu, just drop it into the Playlists 

folder inside the main SoundJam folder.

Once you have a playlist window open, you can add files to it by dragging them from the Finder or 

another playlist into the new playlist window. Choose Save from the File menu to give the new playlist 

a name and to store it in a folder on your Mac.
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COMPOSING NEW PLAYLISTS

When you have a large music col-

lection, you need a bit more help 

in managing all of those songs. 

SoundJam’s Playlist Composer cre-

ates new playlists for you automat-

ically, based on criteria that you 

give it. With Playlist Composer, it’s 

no problem at all to build playlists 

that contain just enough music to 

fill up your portable MP3 player, or 

that only have rock songs that were 

released in 1998.

To build playlists:

1. Choose Compose Playlist from 

the File menu. The welcoming 

Playlist Composer screen appears, as shown in Figure 3-4. Read the introduction, then click Next.

2. In the next screen (Figure 3-5), 

you’ll pick the Source for the 

files you want to add to the new 

playlist, and the Destination for 

the tracks the Playlist Com-

poser will select. The Source 

space starts out with your Mas-

ter Playlist, and you may add 

folders, or other playlists, by 

clicking the Add button and 

navigating to the desired 

source.

Pick the Destination playlist 

from the pop-up menu;  it will 

either be a new playlist, or 

you’ll add to an existing playlist, which must already have been opened in SoundJam. When you’re 

done selecting the Source and Destination, click Next.

Figure 3-4: The first Playlist Composer screen
just tells you what the Composer does.

Figure 3-5: Choose the Source and the
Destination for the new playlist.
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3. This next screen, shown in Fig-

ure 3-6, lets you add files from 

the Source in random order. 

You can also place limits on the 

size of the playlist under Track 

Limits. The first choice, Add all 

matching tracks, adds every 

track that meets the criteria 

that you’ll see in the next step. 

The Limit destination choice is 

the most useful for use with 

portable MP3 players; it lets 

you make playlists that you can 

be sure will fit into the limited 

memory of your MP3 player. 

Enter in a number next to Limit 

destination, then pick minutes, hours, or megabytes from the pop-up menu. Similarly, the Add At 

Most choice allows you to limit the amount of material that you may add to an existing playlist. 

Click Next.

4. The heart of the Playlist Com-

poser is its Criteria screen, 

shown in Figure 3-7. From this 

window, you can create selec-

tion criteria that narrow down 

the files that SoundJam consid-

ers for inclusion in the new 

playlist. Click the Create but-

ton to build a new criterion. 

Let’s say that you want to 

choose just country music with 

the word Love in the title. The 

result would look like 

Figure 3-8. 

Just give the criterion a name at 

the top of the window, pick from the pop-up menus to select which criteria you want, and fill in the 

corresponding blank(s) with any needed information. Click Add Criterion to narrow the search, 

and Remove Criterion to broaden the search.  Click Save to save the criteria for future use. To acti-

vate criteria for use, click the checkbox next to the criterion name, as in Figure 3-7.

Figure 3-6: You can limit the new playlist’s size in this screen.

Figure 3-7: Store playlist criteria in this window.
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When you click the Compose but-

ton, SoundJam processes all of 

your choices and either opens a 

new playlist window reflecting 

those choices, or adds the choices 

to an existing playlist.

EXPORTING PLAYLISTS

On occasion, you might want to 

turn a playlist into a text file. For 

example, let’s say that you’ve cre-

ated a killer sound-mix for a party 

you’re putting on with some 

friends, and you want to share the 

playlist with them before the party. You can’t print a playlist from SoundJam, but you can export one to 

a text file that can be opened up in any word processor, database, or spreadsheet. To do that, just open 

the playlist that you want to export, then choose Export from the File menu. SoundJam will ask you to 

name the exported file, then save it to your hard disk.

The exported file is a plain text file in tab-delimited format, where bits of information are separated by 

tab characters, and with a return character at the end of each track entry. Tab-delimited files can easily 

be read into any word processor, databases such as FileMaker Pro or the database module in Apple-

Works, or by spreadsheets like Microsoft Excel or the AppleWorks spreadsheet module.

FILLING IN MISSING CD TRACK NAMES

When you insert an audio CD or when you load some MP3 files into SoundJam, you’ll notice that 

some columns of the CD or playlist window are empty. All of those potentially useful information col-

umns—Artist, Album, Track Name, and so on—are missing.

Of course, you can input such information manually by highlighting each song name, choosing Get 

Info from the File menu, and typing in the data. (This is the method you must use when organizing 

MP3 files, as opposed to music CDs. See "Adding Track Data Manually" below.)

When your music CD window comes up with missing track names in this way, however, SoundJam 

offers an amazing, automatic means of filling in the missing data: it can consult CDDB, the Internet 

CD Database. This massive, ever-evolving Web site (www.cddb.com), which houses an enormous col-

lection of CD names and their associated track names and other data, has been created over the years 

through the collaboration of thousands of Internet fans. By posting their own new CD data to this 

database, these volunteers save their fellow Internauts — like you—hours of manual data-input labor.

Figure 3-8: narrow your search for tracks to add to your
playlist with the Edit Search Criteria window.
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Here’s how it works:

1. Insert a music CD.

If SoundJam has never seen this 

disc before, a CD window 

opens automatically—but most 

of the information columns 

lack useful names, as shown in 

Figure 3-9.

2. Click Get Names Online.

SoundJam connects to the 

Internet, connects to CDDB, 

looks up your CD, and auto-

matically downloads the track 

and artist information, filling in 

the missing blanks in the win-

dow on your screen. All of this 

takes a moment or two. 

The next time you insert the 

same CD, SoundJam will 

remember the downloaded 

information and display it 

automatically.

✎    Tip: Behind the scenes, SoundJam stores the information about your CD collection in two files called CD 

Remote Programs and CD Remote Programs Plus. They’re in the Preferences folder, which is in your Sys-
tem Folder.

When you want to transfer your CD info to another Mac, or e-mail it to a friend, now you know the secret: 
simply copy these CD Remote Programs and CD Remote Programs Plus files and put them into the identi-
cal folder location on the other machine.

Figure 3-9: A music CD window before (top) and after
(bottom) using the Get Online Names button.
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ADDING CD INFORMATION MANUALLY

If you get MP3 files from the Internet, insert a music 

CD that isn’t in the CDDB database, or make your own 

music file using SoundJam’s Sound Input feature, you’ll 

end up with CDs or MP3 files without track data. 

SoundJam allows you to add the information manually, 

either for a whole CD, one track at a time, or to apply 

the same information to multiple tracks in one step.

To add the basic information about a music CD, make 

sure that the CD’s window is frontmost in SoundJam, 

then choose CD Info from the Edit menu. In the result-

ing dialog (shown in Figure 3-10), enter the artist’s name, the album name, then pick a genre from the 

pop-up menu.

ADDING TRACK DATA MANUALLY WITH THE GET INFO WINDOW

SoundJam’s Get Info window gives you a wealth of information about a track, lets you add track infor-

mation, and even lets you tweak the track’s playback. At the top of the window, you can enter the track 

name.

Try this:

1. Select a track in a playlist, then 

choose Get Info from the File 

menu, or press Command-I. 

The Track Information window 

opens, as shown in Figure 3-11. 

In the Info tab, the window tells 

you the technical data about 

the track.

Figure 3-10: The main CD information window.

Figure 3-11: The Info tab of the Get Info window.
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2. Click the Tags tab.

Here’s where you can enter 

information about the track, 

including the artist, album, 

year, track number, comments, 

and genre, as shown in Figure 3-

12. Some of this information is 

automatically added when you 

do a lookup from CDDB. When 

you add genre information, you 

can either use the pop-up 

menu, or start typing into the 

genre field; SoundJam will try to 

guess the genre and finish 

entering it as you type. 

3. Click the Options tab.

Here, you can tweak the way the 

track behaves on playback. Use 

the Volume Adjustment slider 

to even out the volume of a 

track that was recorded too 

loudly or too quietly. The Equal-

izer Preset pop-up menu lets 

you specify which of your exist-

ing Graphic Equalizer settings 

you want to be used when the 

track plays. And the Start/Stop 

Time area lets you clip off time 

from either the beginning or 

ending of the track.

CHANGING DATA FROM MULTIPLE TRACKS

If you select multiple tracks in a playlist, you can modify all of their tag information in one operation. 

Here’s how:

1. Select more than one track in a playlist.

Figure 3-12: The Tags tab.

Figure 3-13: The Options tab.
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To select multiple contiguous tracks, click on the first track, hold down the Shift key and click on 

the last track. All of the tracks in between will also be selected. To select discontiguous tracks, hold 

down the Command key while clicking on tracks.

2. Choose Get Info from the File 

menu.

SoundJam will ask if you really 

want to edit information from 

multiple tracks. When you click 

Yes, the Multiple Track Informa-

tion window appears, as shown 

in Figure 3-14. Enter the informa-

tion according to the instructions 

in "Adding Track Data Manually 

with the Get Info Window," 

above.

SENDING CD INFORMATION TO CDDB
SoundJam lets you contribute to the CDDB database by sending CD information that you’ve entered 

manually. Most of the time, you won’t need to do this, because someone else has beaten you to it. But 

if SoundJam informs you that there’s no available information for the CD you’ve  inserted after you 

click the Get Names Online button, then you can send the CD and track information to the online 

database.

To contribute to CDDB, bring the CD window to the front, then choose Send CD Info to CDDB from 

the Edit menu. SoundJam connects to the Internet, then sends the information. There’s no acknowl-

edgement from the database.

❈   Alert: It’s very important that you don’t send CDDB track data for CDs that you’ve burned yourself on CD-R 
or CD-RW media. All that would do is clutter up the database with information that won’t be useful for 
anyone else but you, since nobody else has your custom discs. 

Figure 3-14: Change the tag info for lots
of files in one quick operation.
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CHAPTER 4: MAKING YOUR OWN MP3 FILES

As good as it is at organizing MP3 files you collect from the Internet, SoundJam really shines when it 

comes to creating new MP3 files. With a single click, you can turn any track of any music CD—or 

indeed, almost any kind of music file—into an MP3 file suitable for e-mailing, storing on your hard 

drive, or copying onto a portable MP3 player such as the Rio 500, I-Jam, or Nomad II.

STEP 1: CHOOSING THE MUSIC TO CONVERT

SoundJam can convert all kinds of sound files into MP3 or MP2 format:

• Tracks from your music CDs

• AIFF sound files

• The sound tracks of QuickTime movies

• WAV files (the most common sound-file format on Windows)

• “snd” files (Macintosh sound files, sometimes known as System 7 sound files)

• MOD files (MODule files, which contain samples of digital instruments and instructions for 

sequencing and playing those samples.)

• Other sound-file formats for which plug-ins may become available

You can select the files you want to convert in any of several ways:

• Insert a music CD. From the Window menu, choose Audio CD (or the name of the CD). Click the 

name of the track you want to convert to MP3, and then click Add to Converter.

✎    Tip: You can select multiple CD tracks for conversion to MP3 by pressing the Command key as you click 

their names. Or, to select a number of consecutive tracks, click the first one—and then Shift-click the last 
one you want to include. After highlighting several names in this way, click Add to Converter.
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• From the Window menu, 

choose Converter. Insert a 

music CD into your Macintosh. 

When its icon shows up on your 

desktop, double-click it. You’ll 

see icons representing the 

tracks on the CD, as shown in 

Figure 4-1. Drag the tracks you 

want into the Converter win-

dow, also as shown in 

Figure 4-1.

• From the Window menu, 

choose Converter. Return to 

your desktop, where you can 

now drag AIFF, WAV, “snd,” MOD, or QuickTime file icons directly into the Converter window.

• From the Window menu, choose Converter. Drag any file icon from any playlist window into the 

Converter window.

STEP 2: SETTING UP THE CONVERSION

After indicating which files you want to convert (by loading them into the Converter window), you can 

tell SoundJam exactly how you want these files processed. 

✎    Tip: Unless you’re a true audio aficionado, you’ll probably find some of the following settings extremely 

technical. For most purposes, you won’t need to change any of the options discussed here. SoundJam 
offers them, however, to provide you with extra control when answering the question: “What is more 
important to me: the quality of the sound—or the size of the resulting sound files?”

THE “CONVERT USING:” POP-UP MENU

As shown at lower left in Figure 4-1, the first decision you must make is whether you want SoundJam 

to create MP3, MP2, or AIFF files. Your choices from this pop-up menu are SoundJam MP3 Encoder, 

SoundJam MP2 Encoder, and SoundJam AIFF Encoder.(Future versions of SoundJam may let you cre-

Figure 4-1: Drag tracks directly from the CD into
the SoundJam Converter window.
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ate other sound-file formats.) MP3, MP2 and AIFF (Audio Interchange File Format) are standard 

sound files that can be played on either Macintosh or Windows. Here are some of the differences:

In general, then, you’ll want to create MP3 files if you plan to play the music back from your hard drive 

or from a portable MP3 player; you’ll want to create AIFF files if you plan to burn your own music CDs. 

MP2 files can’t be played back on portable devices, so they can only be played back from your hard 

drive. Some people believe that MP2 files are musically superior to MP3 files, so if you need maximum 

fidelity, consider MP2.

MP3 Files MP2 Files AIFF Files

Cannot be played by a standard CD player (but you can burn 

these files onto a CD, which can then be played by SoundJam).

Can be played by a standard 

CD player— which is useful if 

you own a CD-ROM burner 

and want to create your own 

custom CDs.

High compression of original 

audio file, while maintaining 

good fidelity.

Less (but still significant) 

compression and better 

musical fidelity.

Remains at full size—Sound-

Jam doesn’t perform com-

pression.

Can be created with great control using SoundJam’s configura-

tion window.

SoundJam offers no configu-

ration settings.

Can be played on portable 

music players like the Rio 

500.

Can’t be played on portable 

music players.

Can’t be played on portable 

music players.

Can be played on both Macintosh and Windows with the 

appropriate software.

Can be played both on Mac-

intosh and Windows with the 

appropriate software.

Incompatible with most pre–1998 sound software. Compatible with almost any 

sound software, including 

many shareware programs.
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THE CONFIGURE BUTTON FOR MP3 ENCODING

If you decide to create MP3 or MP2 

files, you’ll find that SoundJam 

offers a host of additional controls 

which you can access by clicking 

Configure. (If you’re creating AIFF 

files, the Configure button is 

dimmed because there’s nothing 

else to set up in SoundJam.) 

Here’s what you’ll find in the dialog 

box that appears when you choose 

the Configure button for the 

SoundJam MP3 Encoder, as shown 

in Figure 4-2:

BIT RATE POP-UP MENUS

These two pop-up menus—one each for Mono and Stereo—are among the most useful in the 

dialog box. The higher the kbps (kilobits per second), the better the resulting MP3 file will 

sound—and the more space it will take up on your hard drive, disk, or portable MP3 player.

So what setting should you choose? The answer depends on your purpose:

• The most commonly used bit rate for stereo MP3 files is 128 kbps. At this rate, you’ll just 

barely be able to tell that the sound isn’t as good as on the original CD—but the resulting 

sound file takes up less than 10 percent as much disk space as the original CD track. This is a 

good option for creating MP3 files you plan to load onto a machine with limited memory, 

such as the Rio 500, I-Jam, or Nomad II MP3 players. And given the quality of the head-

phones used with most mobile devices, chances are that the 128 kbps bit rate will be the 

perfect trade-off between file size and audio fidelity. This is SoundJam’s default bit rate set-

ting.

• The next higher option—160 kbps for stereo—may be the best one for music you plan to lis-

ten to over a stereo system or through high-quality computer speakers. Although the result-

ing file is slightly larger than a 128 kbps MP3 file, you’ll probably find the trade-off worth it: 

at this bit rate, the sound quality is almost indistinguishable from that of a CD.

• Use lower numbers for sound files containing, for example, voice recordings (instead of 

music). Using lower bit rates means that far more sound can be stored on a disk, your hard 

drive, or a portable MP3 player.

Figure 4-2: Configuring MP3 encoding.
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VARIABLE BIT RATE ENCODING (VBR)
Variable Bit Rate encoding lets SoundJam change the bit rate dynamically depending on the 

characteristics of the material being encoded. The idea here is that on audios which don’t have 

much dynamic range (dynamic range is the difference between the softest and loudest parts of 

the program), as with voice recordings, SoundJam won’t use the same high bit rate that it uses 

for material with a large dynamic range, such as orchestral music. Instead, SoundJam will sam-

ple the program and adjust the bit rate as needed. With VBR enabled, SoundJam uses the Bit 

Rate pop-up menu as the guaranteed minimum bit rate. By default, VBR is turned off, because 

the audible differences it offers are subtle. Feel free to experiment with it and see if it makes a 

difference to your recordings.

❈   Tip: Because of a bug in the Rio 500’s firmware (versions 1.04 and earlier), tracks recorded with VBR show 
incorrect playing times in SoundJam’s Rio 500 window (see Chapter 5).

PERFORMANCE

Just as there’s a trade-off in file size versus audio fidelity, the Performance section lets you 

decide what is more important to you: faster encoding speed, or higher quality of the final MP3 

file. If you have a lot of CDs you’re planning on encoding, and a limited amount of time or a 

slower Macintosh, then the Faster choice might make sense. Most of the time you’ll probably 

want to stay with Best Quality, the default choice. 

SAMPLE RATE

As with the Bit Rate pop-up menu, this control lets you make a trade-off between the size of the 

resulting MP3 file and the sound quality of the playback. In general, the best choice here is Auto; 

the Bit Rate pop-up menu is a far more effective tool for making quality/file size adjustments.

For your reference, however, CD quality is 44.100 kHz (kilohertz); anything higher wastes mem-

ory and disk space. Cheap AM radio quality is about 22 kHz; you might conceivably use this set-

ting for voice recordings.

CHANNELS

If you plan to listen to music on your desktop Mac’s solitary built-in speaker, creating stereo 

files (those with right and left channels of sound) is simply wasting disk space. In such a case, 

choose Mono here. (A mono file takes up less than half the space of a stereo file.)

On the other hand, if you’ll be listening to these MP3 files using your stereo system, a portable 

MP3 player, a stereo PowerBook or iMac, or a pair of external speakers you’ve attached to your
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Mac, use the Stereo or Auto buttons instead. Actually, Auto is almost always the best choice—it 

converts tracks that are already monaural into mono MP3 files, and stereo files into stereo MP3 

files.

STEREO MODE

In Normal mode, your MP3 file contains two independent tracks: one each for the right and left 

stereo channels. In most cases, however, the two channels contain a lot of related information. 

The special, space-saving Joint Stereo mode takes advantage of this fact, making an attempt to 

store, for example, only the information that is different between the two channels. The result 

isn’t identical to a true stereo file, but you probably won’t be able to tell the difference by listen-

ing, and the quality improvement—because SoundJam can use more data to describe the pri-

mary musical material—can be substantial.

USE DEFAULT SETTINGS

Click this button to reset all the controls in this dialog box to their original, factory-set settings.

THE ADVANCED BUTTON

Click this button to gain access to the 

Advanced encoding settings, shown in 

Figure 4-3.

SMART FREQUENCY REDUCTION

In creating an MP3 file, SoundJam generally 

discards sound in the sonic spectrum above 

16 kHz, in the interest of saving disk or mem-

ory space. (Most people can’t tell whether or 

not sounds above that frequency are even 

present.) If you turn on this checkbox and 

your chosen bit rate is below 128, SoundJam will eliminate the very highest frequencies in the 

source material, in an effort to preserve the most sound data for the middle of the sonic range. 

This setting has no effect when encoding at 128 kbps and higher. We recommend that you leave 

this checkbox enabled.

FILTER FREQUENCIES BELOW 10 HZ

The lowest audio frequencies can’t be heard by most people (or reproduced by most speakers 

and headphones), so SoundJam gives you the option of filtering them out and using the saved 

space to more faithfully reproduce frequencies which are easier to hear.

Figure 4-3: The MP3 encoder’s
Advanced settings dialog box.
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ADD ID3 INFORMATION TAGS

Many MP3 files on the Internet come equipped with ID3 tags, which are small bursts of useful 

information that are stored along with music data in the files themselves. This information pro-

vides the name of the song, artist, album, and so on—exactly the kind of information that 

SoundJam can show in its playlist window. (If you ever encounter an MP3 file that’s missing its 

song, artist, and album names, you’ll know why—the MP3 file was lacking an ID3 tag.) The ID3 

tag contains the CDDB information (see Chapter 3 for more on CDDB).

When this checkbox is turned on, SoundJam adds this information to the MP3 file you’re creat-

ing (if, in fact, your source material—such as the CD track you’re converting—offers such infor-

mation). There’s little reason to turn this option off; only the oldest and least sophisticated MP3 

players are incapable of playing MP3 files that contain ID3 tag information.

MPEG FILE OPTIONS

These are three settings that can be added to every encoded file. The checksum verifies the 

integrity of the file. The original setting indicates, if set, that the file is located on its original 

media. The copyright setting tells other encoders that copying the file is disallowed. By default, 

all of these settings are off.

THE CONFIGURE BUTTON FOR MP2 ENCODING

When you set the Convert Using 

pop-up menu to SoundJam MP2 

Encoder, the options in the Config-

ure dialog are different (though 

similar to MP3 encoding), as shown 

in Figure 4-4:

All of the options in this dialog box 

work in much the same fashion as 

they do for MP3 encoding; see the 

discussion above for information 

about each option. The main difference is that MP2 encoding offers a different set of bit rates, includ-

ing bit rates that are of higher quality than MP3 offers. The options in the MP2 Advanced setting dialog 

are identical to those in the MP3 Advanced settings; see above for more information.

Figure 4-4: MP2 encoding options.
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STEP 3: CONVERTING THE FILES

After you’ve set up the conversion the way you want it—and have closed the SoundJam MP3 Encoder 

dialog box by clicking OK—you’re ready to begin the conversion process. One last time, you can take a 

moment to survey the list of tracks you’ve prepared for converting. You can manipulate the Converter 

window just as you’d manipulate the playlist window, described in Chapter 2. For example, you can 

control how the files are sorted and which information columns appear. 

✎    Tip: If you change your mind about one of the files, you can remove it from the list by highlighting its 

name and then pressing the Delete key.

When the list looks good, click Start Converting.

Creating a standard-length MP3 

file takes a minute or two; a 

progress bar shows you how much 

longer the job will take, as shown 

in Figure 4-5. (Playing music, 

visual plug-in displays, Internet 

downloads, and running other Mac 

programs can make the process 

take longer.) The window in Figure 

4-5 provides a running readout of 

the time remaining for the conver-

sion of the current track—click this 

display to change it to Time 

Elapsed—and the speed of the 

conversion. (This last statistic is 

displayed in the form “3.5x,” which 

shows how many times faster the 

conversion is going than real play-

back time.) 

If your CD-ROM drive is fairly modern, SoundJam achieves high speed using asynchronous encod-

ing—that is, it simultaneously reads your CD disc and saves the MP3 file in progress on your hard 

drive. 

Figure 4-5: During the conversion, click Time Remain-
ing to change the display to Time Elapsed.
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✎    Tip: Some older CD drives and some off-brand CD driver software don’t offer asynchronous operation. In 

these cases, SoundJam must first transfer the sound data from the CD onto your hard drive (or whatever 
drive you’ve specified using SoundJam’s Preferences command, as described in the next chapter). Only 
then does the actual conversion process begin.

When the conversion is over, SoundJam opens its playlist, where the converted files now appear, ready 

for playing.

Behind the scenes, SoundJam places its newly created MP3, MP2, or AIFF files into the Music folder, 

which is inside the SoundJam folder. That’s useful to remember when you want to locate one of your 

homemade music files in order to back it up, e-mail it to someone, or delete it. If you want SoundJam 

to put files it creates somewhere else, use the Select Conversion Destination button in the Converter 

panel of the Preferences window.

USING THE VELOCITY ENGINE

The PowerPC G4 processor used in newer Power Macintoshes contains a special processing unit that 

Apple calls the Velocity Engine. This unit is great at some specialized tasks, such as very fast process-

ing of audio and video files. The catch is that applications have to be rewritten to take advantage of the 

Velocity Engine’s turbocharging. SoundJam was one of the first programs to include Velocity Engine 

support, and it significantly trims the time it takes to encode MP3 and MP2 files—by as much as 50% 

faster. Best of all, you don’t have to do anything to use the Velocity Engine. If your computer has a G4 

processor, SoundJam takes note and automatically switches into Velocity mode. Just sit back and 

enjoy the ride!
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CHAPTER 5: SOUNDJAM AND PORTABLE MUSIC PLAYERS

One of the best things about using MP3 files is their portability; you can easily move them from one 

computer to another, because MP3s pack so much music into such a small space. But it’s hard to strap 

a computer to you when you go for a jog, so the ultimate solution for portable music is portable MP3 

players. These tiny units (about the size of a pack of playing cards) have solid-state memory that holds 

hours (current models hold as much as three hours) of near CD-quality music. Speech files, such as 

audio books, typically take up much less space than music, so you can fit up to 30 hours of spoken 

words into a portable player, which is enough for even the longest audio books.

MP3 portable players have no moving parts, so you never get skips in your music when you hit a 

bump in the road. Because the music is coming out of RAM in the player, you truly have random 

access to your music. And depending on the player’s display, you can see the song title, artist, elapsed 

time of the track, and more. Some portable players even have built-in FM radios, so when you’ve lis-

tened to all of the MP3s you’ve brought along, the music doesn’t have to stop.

SoundJam supports three portable MP3 players: the Diamond Multimedia Rio 500, the Creative Labs 

Nomad II, and I-JAM Multimedia’s I-Jam Player. With all of these players, SoundJam makes it easy to 

transfer MP3 files from your computer to the players over a speedy USB connection. It only takes a few 

minutes to load your portable soundtrack and you’re ready to roll.

✎    System Requirements: In order to transfer music to the these portable players, you’ll need a Macintosh that 

has a USB (Universal Serial Bus) port, such as an iMac, an iBook, or a recent PowerBook, G3 or G4-based 
desktop Macintosh. If you have an older Macintosh, you’ll need to get a USB PCI card adapter, which 
plugs into one of your Mac’s expansion slots.

WORKING WITH THE RIO 500
To get started with the Rio 500, make sure that your Rio 500 is turned on, and that the wide end of the 

USB cable that came with the Rio 500 is plugged into your Mac. When you plug the other end of the 

USB cable into your Rio 500, two things happen: the main Rio screen appears, as shown in Figure 5-1, 

and an entry for the Rio window is added to SoundJam’s Window menu.
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THE RIO 500 WINDOW

A. RioPort logo—Clicking this 

logo launches your Web 

browser and brings you to 

www.rioport.com, Diamond 

Multimedia’s Web site with a 

huge compendium of down-

loadable MP3 tracks. You can 

find music of virtually any 

genre here, as well as tons of 

spoken word files, including 

comedy, audio books, and even 

old-time radio shows.

B. Folder Pop-up Menu—The Rio 

500 allows you to create folders 

within the device’s memory, 

which you can use for music from different artists, different albums, or whatever else you want. 

You can create and name one or more folders for music, or have different folders for spoken word 

files. It’s up to you. The folder pop-up menu changes the playlist below to reflect the contents of 

the selected folder. The Rio 500 has 64 Mb of memory built-in, and it accepts 16 Mb or 32 Mb 

SmartMedia memory cards in its memory slot, for a maximum memory of 96 Mb. The folder pop-

up menu always tells you if the folder resides on the internal memory, or on the memory card.

C. Content Gauge—The content gauge is a graphical view of how full the memory in your Rio 500 is. 

Above the gauge is text giving you the amount of memory used, out of the storage location’s total 

memory.

D. Playlist—Like all of the playlists in SoundJam, this one gives you the option of multiple columns, 

and you can change a column heading by clicking on it and making a choice from the resulting 

pop-up menu. In the Rio 500 window’s playlist, the first column lets you list by date, name, play 

order, size, or time. Subsequent columns allow you to list by date, size, or time. At the top of the 

playlist you’ll find a display of how many items are in the playlist, the total time of those items, and 

how much space those files take up.

✎    Tip: Because of a bug in the Rio 500’s firmware (versions 1.04 and earlier), tracks recorded with Variable 

Bit Recording show incorrect playing times in SoundJam’s Rio playlist window (see Chapter 4 for more 
about VBR).

Figure 5-1: Everything you need to work with the
Rio 500 is accessible from this window.
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E. Add Track Button—Clicking this button brings up the standard Macintosh get file dialog box, 

where you can select files that you want to add to the playlist. It’s much easier, however, to simply 

drag files from another SoundJam playlist or the Macintosh Finder into the Rio 500 playlist. As 

soon as you drag the files, SoundJam transfers the files to the Rio 500.

✎    Tip: If you attempt to drag more files to the Rio 500 than its memory will hold, SoundJam will copy all the 

files that will fit, and will simply refuse to copy any more.

F. Create Folder Button—Clicking this button 

brings up a dialog box that allows you to create 

and name a folder in the Rio 500’s unused mem-

ory, as shown in Figure 5-2. The Media pop-up 

menu allows you to create the folder in the inter-

nal memory or (if installed) a memory card. Just 

type in the new folder name, and click the OK but-

ton.

G. Delete Folder Button—This button lets 

you delete the currently selected folder 

and everything in it. Because this opera-

tion erases data inside the Rio 500, Sound-

Jam asks you to confirm the deletion, as in 

Figure 5-3.

H. Rename Folder Button—This feature lets 

you rename the currently displayed folder. Enter 

the new folder name, and click the OK button, as 

shown in Figure 5-4.

I. Erase Player Button—This option brings up a 

dialog box identical to the one in Figure 5-2, but 

the function of this one is very different. Clicking

Figure 5-2: Creating a new folder in the Rio 500.

Figure 5-3: SoundJam won’t let you delete information
without making sure that you’re sure.

Figure 5-4: It’s easy to update folder names.
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OK here will erase the entire contents of either the internal memory or a memory card, depending 

on which you select from the Media pop-up menu. 

J. Player Settings Button—Click this button to 

name your Rio 500, as shown in Figure 5-5.

WORKING WITH THE NOMAD II
Creative Labs’ Nomad II is both an MP3 player and a portable FM radio. Unlike the Rio 500, the 

Nomad II has no built-in memory; instead, it relies on a 64 MB SmartMedia card to store your tunes. 

To begin with the Nomad II, plug the rectangular end of the USB cable into your Mac and the square 

end into the Nomad. Two things occur: the main Nomad screen appears, as shown in Figure 5-6, and 

an entry for the Nomad window is added to SoundJam’s Window menu.

✎    Tip: Some models of the Nomad II allow you to use the device as a voice recorder. The voice files that the 

Nomad II created have the .nvf file extension, and SoundJam can manipulate and play these files in the 
same way it works with any other file.

THE NOMAD II WINDOW

A. NomadWorld logo—Clicking 

this logo launches your Web 

browser and brings you to 

www.nomadworld.com, Cre-

ative Labs’ Web site. It includes 

music downloads, information 

about the Nomad hardware 

and accessories, and more.

Figure 5-5: The Settings button lets
you name your Rio 500.

Figure 5-6: The Nomad II window.
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B. Content Gauge—The content gauge is a graphical view of how full the memory in your Nomad II 

is. Above the gauge is text giving you the amount of memory used, out of the memory card’s total 

memory.

C. Playlist—This playlist gives you the option of multiple columns, and you can change a column 

heading by clicking on it and making a choice from the resulting pop-up menu. In the Nomad II 

window’s playlist, the first column lets you list by date, name, play order, or size. Subsequent col-

umns allow you to list by date or size. At the top of the playlist, you’ll find a display of how many 

items are in the playlist and how much space those files take up. 

✎    Tip: MP3 files in the Nomad II’s playlist seem to be named differently than when they appear elsewhere in 

the program. That’s because the Nomad takes the file’s name and converts it into a DOS-compatible file-
name, with eight characters followed by the .mp3 file extension. It looks clunky to Mac users, but fortu-
nately when the Nomad II actually plays the files, it displays the song’s actual title (as listed in the song’s 
ID3 tag info). 

D. Add Track Button—Clicking this button brings up 

the standard Macintosh get file dialog box, where 

you can select files that you want to add to the play-

list. It’s much easier, however, to simply drag files 

from another SoundJam playlist or the Macintosh 

Finder into the Nomad II playlist. As soon as you 

drag the files, SoundJam transfers the files to the 

Nomad II, and keeps you updated on the transfer’s progress, as shown in Figure 5-7.

✎    Tip: If you attempt to drag more files to the Nomad II than its memory will hold, SoundJam will copy all 

the files that will fit, and will simply refuse to copy any more. 

E. Rename Track Button—Clicking this button with 

a track selected in the Playlist brings up a dialog 

box that allows you to rename the track. See Fig-

ure 5-8.

F. Erase Player Button—This option will erase the 

entire contents of the Nomad II’s memory card. 

Because this operation erases data, SoundJam 

asks you to confirm the deletion.

Figure 5-7: Tracking the progress of a file
transfer to the Nomad II.

Figure 5-8: The Nomad II allows you to
rename tracks on the device.
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G. Player Settings Button—Click this button to name your Nomad II. You can also use this button to 

create up to 32 presets for the Nomad’s FM tuner. See your Nomad II User Manual for details.

WORKING WITH THE I-JAM PLAYER

Like the Nomad II, the I-JAM Multimedia’s I-Jam Player is both an MP3 player and a portable FM 

radio. It uses a different type of flash memory card than the Nomad and Rio; where those players use 

the SmartMedia card format, the I-Jam uses the physically smaller MultiMediaCard format that holds 

either 16 Mb or 32 Mb of memory. 

TRANSFERRING FILES TO AND FROM THE I-JAM PLAYER

The I-Jam Player comes with a USB card reader that accepts the player’s MultiMediaCard. Install the 

card player according to the directions that come with it, and install the card reader’s driver software.

Insert the MultiMediaCard into the card reader. An icon for the MultiMediaCard will appear on your 

Mac’s desktop, much like any removable media, such as a floppy disk, or Zip disk. You can treat the 

MultiMediaCard as you would any disk you use with the Mac. To copy MP3 files to the MultiMed-

iaCard, drag them from the folder where they reside on your hard disk, or drag files from any Sound-

Jam playlist, to the MultiMediaCard’s icon on your desktop.

To erase files from the I-Jam Player’s MultiMediaCard, double-click on the card’s icon on your desktop, 

select the files that you want to delete, drag them to the Trash, and choose Empty Trash from the 

Finder’s Special menu.
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CHAPTER 6: SOUNDJAM, MENU BY MENU

The preceding chapters introduce you to SoundJam, feature by feature. This chapter is for your refer-

ence: it covers each of SoundJam’s menus—and the windows that these menus summon.

APPLE MENU

The Apple menu contains two general SoundJam choices, described below:

ABOUT SOUNDJAM™ MP PLUS

This command shows you credits for the people involved in SoundJam’s creation, as well a some regis-

tration information.

REGISTER ONLINE

Choosing this starts the SoundJam Setup Assistant, which steps you through the online registration 

process and some basic SoundJam settings. Take a minute and register to get access to technical sup-

port, and to be informed of updates when they happen.

FILE MENU

The File menu lets you open and close files and playlist windows.

NEW PLAYLIST 
As described in Chapter 3, you can create as many different playlists as you want, each containing 

music organized for a specific purpose. This command opens up a new, untitled playlist window. See 

Chapter 3 for instructions on managing your playlists.

OPEN PLAYLIST

This menu item leads to a hierarchical menu that contains all of the playlists that are inside the Play-

lists folder, inside of the main SoundJam folder. It’s an easy way to switch between your playlists.

COMPOSE PLAYLIST

Pick this command to open the Playlist Composer. See Chapter 3 for detailed instructions on using 

the Playlist Composer.

OPEN

This command opens the standard Open File list window, so that you can navigate to, and open, any-

thing SoundJam can open: an MP3 file, QuickTime file, AIFF file, playlist, CD track, and so on.
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OPEN URL
Choose this command to summon the dialog box 

shown in Figure 6-1. Type an Internet Web address 

into this box and click OK to play an MP3 stream (an 

MP3 file that’s sent to you live over the Internet). 

SoundJam connects to the Internet and the stream 

begins to play. If the Web address ends in .mov, 

you’re probably tapping into a Web page that offers 

a streaming QuickTime audio file, which SoundJam 

will begin playing automatically.

CLOSE WINDOW

This command closes whatever window is in front. If you close the Player (control panel) window, 

SoundJam quits.

GET INFO

After highlighting a sound file in a playlist window, use this command to open the Track Information 

dialog box in which you can edit the file’s name, artist, album, and other textual information. This 

information is also known as the ID3 tags for MP3 and MP2 files. Selecting multiple files before choos-

ing Get Info allows you to make changes to all of those files in one operation.

SHOW ORIGINAL

After highlighting a sound file in a playlist window, use this command to bring the Finder to the fore-

ground and show you this file.

CONVERT ID3 TAGS

Converts or removes (or adds, if absent) versions of a track’s ID3 tags, which contain information 

about the file’s name, artist, album, and other textual information. As the MP3 standard has evolved, 

different versions of the ID3 tags have evolved along with it. Use this command to make all the ID3 

tags in your music collection up-to-date. It also will allow you to convert text between ISO Latin-1 and 

ASCII. This is useful for foreign language system compatibility with other MP3 players and encoders 

that store ID3 tags in ASCII.

PLAY FROM SOUND INPUT

Plays audio from the input source selected in the Mac OS Sound control panel.

RECORD FROM SOUND INPUT

Creates a new MP3 file from the input source selected in the Mac OS Sound control panel. Especially 

useful for converting vinyl records or cassette tapes into digital format.

Figure 6-1: The Open URL window lets you play
an MP3 stream from the Internet.
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SAVE, SAVE AS, SAVE A COPY AS

If you’ve made changes to the currently open playlist, the Save command preserves them, exactly like 

the Save command in a word processor or any other program. As in other programs, use Save As when 

you want to create a copy of the current playlist—with a different name—that then remains on the 

screen.

The Save a Copy As command is almost the same as Save As—except that when you’re finished nam-

ing the copy of your playlist, the original playlist remains open on the screen.

✎    Tip: you can easily tell whether a playlist has been changed since it was opened. Just look at the small icon 

next to the playlist window’s title. If the icon is dimmed, the playlist has been modified.

EXPORT

Exports the frontmost playlist’s contents as a tab-delimited text file.

QUIT

This command quits SoundJam.

EDIT MENU

The Edit menu’s most relevant SoundJam feature is its Preferences command.

UNDO, CUT, COPY, PASTE, CLEAR, SELECT ALL 
These commands work as they do in any Macintosh program—in SoundJam, they’re primarily useful 

for editing the names of your tracks. Clear lets you delete the elected file from the active playlist. Com-

mand-Clear will bypass SoundJam’s “Are you sure?” dialog box.

JOIN CD TRACKS

Sometimes consecutive tracks on a CD will have been designed for playback without interruption. By 

joining these tracks together into a single sound file when you convert them, you can eliminate any 

pause between them during playback. It also will keep them together for shuffle play.

To join CD tracks together, first add them to the Converter window. Then select them in the Converter 

window and choose the Join CD Tracks command. This will merge the two or more consecutive tracks 

into a single track for conversion.
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CD INFO

A CD has information that you might want to edit separately from the individual tracks (for example, 

the album title or artist). With a CD window in the foreground, choose this command to edit this 

information.

SEND INFO TO CDDB
This command sends information about a CD to CDDB, the Internet music database. It allows you to 

be a contributor to this volunteer-built database. Make sure to only send information on commercial 

CDs that you’ve already found aren’t in the CDDB; don’t send information about custom CDs that 

you’ve burned for your own use.

GET INFO FROM CDDB
This command allows you to retrieve track, artist, and album information from CDDB and apply it to 

tracks that you converted without having already done a CDDB lookup. This is great if you converted 

CD’s at a time when you didn’t have an Internet connection available. Only works on files that you 

converted with SoundJam 2.0 or later.

PREFERENCES

Choose this command to display 

the Preferences dialog box, shown 

in Figure 6-2. By clicking the icons 

at the left side of the window, you 

can summon different panels, 

each containing settings that gov-

ern different aspects of SoundJam’s 

behavior.

GENERAL

This panel offers several 

checkboxes that govern 

SoundJam’s overall behavior:

• Display Track Number 

in Name—On a CD, 

SoundJam can either 

show you a list of track 

names (“Overture,” “The Beginning,” and so on)—or, when this option is turned on, a list of 

track names preceded by the track numbers. The result is “1. Overture,” “2. The Beginning,” 

and so on. 

Figure 6-2: The Preferences dialog box is
divided into multiple panels.
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• Display Skins Using Transparency—This allows skinned windows to have transparent lay-

ers. For example, skinned windows can now cast transparent drop-shadows on the items 

below them. 

• Live Window Dragging—Updates the window in real-time while you drag the window. No 

longer will you see just the outline of the window as you move it around.

• Reduce CPU Use When in Background—Processing music data is hard work, even for a fast 

Macintosh; if you like to listen to SoundJam music while working in other programs, you 

may notice that your Mac feels slower than usual. If you’d prefer SoundJam to use up less of 

your Mac’s horsepower when playing music in the background, turn on this option.

• Quit Application When Closing Player—When this option is selected, the application will 

quit when you close the Main Player window. (Deselecting this option is useful when you 

want to close all open windows and just use the player without any visual stimulation.)

• Reverse Balance Slider—Turn on this option if you want SoundJam to swap the balance 

control for the left and right playback channels. You might use it if, for example, you’ve inad-

vertently put on your headphones backwards, or if you own a Macintosh model whose right 

and left channels are reversed.

• Require Confirmation When Deleting—When this is checked, SoundJam will put up a con-

firmation dialog box when you delete items from playlists.

• Use SoundJam for Internet Playback—Click this button. After that, when you listen to 

streaming audio from the Internet, as described in Chapter 4, there’s nothing to configure— 

SoundJam automatically detects and intercepts that audio stream and begins to play it. 

✎    Tip: When you turn on this option, SoundJam automatically updates your Internet Config files—the prefer-

ences you set using the Internet control panel in Mac OS 8 and later, or using the free Internet Config 
extension in earlier systems—to record your preference. 

• On CD Insert—This option lets you control what SoundJam will do when a new CD is 

inserted. The options are: Do Nothing, Begin Playing, Convert All Tracks, and Convert All 

Tracks & Eject. This lets you setup SoundJam to perform quick batch conversions of your CD 

collection. 
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PLAYER

• Scroll Title Display—SoundJam will automatically scroll titles that are too long to display in 

the player window. It will also cycle between the currently selected track’s album, artist, and 

track names.

• Resume Playback At Startup—Resumes playback at the point in the track when SoundJam 

MP last quit.    

• Play Tracks While Converting—SoundJam has a very powerful feature that allows you to 

play a track while it is being converted! This means that you can hear the results of the con-

version while still performing the conversion at full speed. When you start converting, if the 

CD driver is capable of extracting while converting (most Apple CD drivers can), the track 

will be added to the playlist right away and playback will begin. Otherwise, playback will 

begin after the first track has been converted.

This feature does require that your computer be capable of converting faster than real-time 

while still performing the playback. A G3 processor or better is recommended. 

• Play One Track at a Time—After playing each track, SoundJam will stop on the next track. 

This allows SoundJam to be used like a “cart” machine used in radio stations, with the space 

bar starting the next track.

• Use CD Digital Audio Playback—Your Mac can play music from an audio CD in either of 

two ways: directly from the CD player, or via the Mac’s own circuitry.

When the CD player plays music directly—which it does when you turn this checkbox off—

the music is sent straight to the Mac’s Sound Out jack, bypassing the Mac’s innards. 

When this checkbox is turned on, however, the music is sent into the Macintosh and pro-

cessed—the great advantage is that SoundJam’s graphic equalizer, visual feedback screens, 

and other audio features can then interact with the music.

There are only three cases when you’ll benefit by turning off this option: (1) You have an 

older CD-ROM drive that doesn’t communicate with SoundJam otherwise; (2) You’re run-

ning computation-intensive programs on your Mac, and SoundJam’s music-processing fea-

tures are slowing things down; or (3) You’re a purist who resists any kind of sonic processing 

of the music that’s passed from your Mac’s CD drive to your stereo.

• Preload Files into Memory—This feature lets SoundJam use a portion of RAM to preload 

into memory the next files to be played (this feature uses temporary memory, so there’s no 

need to increase SoundJam's memory partition in the Finder). This is for PowerBook users 
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so that SoundJam will NOT spin up (or keep spun up) the hard disk. It’s very important for 

preserving battery life. SoundJam will attempt to keep the buffers full whenever it has to go 

to the disk to load a track. Whenever it encounters a track it has to read, SoundJam will do 

the prereading. You can specify how much RAM SoundJam will set aside as the buffer space.

• Shuffle–Keep Album’s Tracks Together—With this option selected, SoundJam will shuffle 

entire albums withing the playlist. 

• Shuffle–Shuffle Album’s Tracks—With this option selected, SoundJam will shuffle the tracks 

within an album, but still keep the album’s tracks together. 

FILES

This panel’s checkboxes pertain to SoundJam’s handling of sound files on your hard drive.

• Change File Creator to SoundJam—Every time SoundJam opens an MP3, AIFF, WAV, or 

other SoundJam-recognizable file, the program marks the file as one of its own—behind the 

scenes, the program changes the file’s invisible Macintosh creator code to match Sound-

Jam’s. The advantage of this system is that, henceforth, you’ll be able to double-click that 

MP3 file on your desktop to launch SoundJam (instead of having to drag its icon into the 

SoundJam window, for example). If you’d prefer that SoundJam refrain from stamping MP3 

files with its own parenthood, turn off this option. (SoundJam never adopts QuickTime files 

in this way, however, even though it’s technically capable of playing audio QuickTime files.)

• Update Incorrect File Types—In the Windows world, an MP3 or AIFF file identifies itself 

with the appropriate letters (.mp3 or .aif) at the end of its name. On the Mac, as noted 

above, the corresponding identification is provided by an invisible, four-letter creator code.

Many sound files downloaded from the Internet arrive with no four-letter Mac codes, 

because such files were originally designed to be played only by Windows computers. When 

this option is turned on, whenever SoundJam observes a familiar suffix (such as .mp3) on 

the downloaded file’s name, it adds the necessary Mac Creator code automatically. 

✎    Tip: If you download a sound file from the Internet that SoundJam doesn’t seem to recognize, it may be 

because the file has neither a Windows-style “.mp3” suffix nor a Mac-style Creator code. Try adding the 
necessary suffix to the name yourself; SoundJam may now be able to open the file.

• Delete Temporary URL Files—Sometimes, when you play a streaming audio file (see Chap-

ter 3) from the Web, the Web site in question deposits a small file on your desktop (often 

with a suffix like .M3U or .PLS). This file is for the Web page’s use, not yours—when the play-
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back is over, you have no choice but to throw away this piece of Internet lint. When this 

checkbox is turned on, SoundJam does the throwing away for you.

• Add Extension to Filename—When you create new MP3 or AIFF files, this option makes 

SoundJam add the correct Windows-style suffix (.mp3 or .aif) to the end of the resulting 

files’ names. This option is useful only if you plan to use your newly created files on a 

Windows PC.

• Add Track Number to Filename—This option makes SoundJam add the track number (from 

the original CD) to the name of MP3 and AIFF files it creates.

• Create Files in Artist Folder—When you use SoundJam to generate new MP3 or AIFF files, it 

places them into a folder bearing the name of the artist of the original CD (inside the Music 

folder, inside the SoundJam folder). If you turn this option off, SoundJam puts newly created 

MP3 files directly into its Music folder (in your System file folder).

• Create Files in Album Folder—When you use SoundJam to generate new MP3 or AIFF files, 

it places them into a folder bearing the name of the original CD (inside the Music folder, 

inside the SoundJam folder). If you turn this option off, SoundJam puts newly created MP3 

files directly into its Music folder (in your System file folder). If the Create Files in Artist 

Folder option is on, this folder will be created within the artist’s folder.

PLAYLISTS

• Ask Before Saving Playlist Changes—Each time you close a playlist window to which you’ve 

made changes, SoundJam prompts you to confirm that you want to save the changes. If 

you’d rather not be asked, turn off this option; now SoundJam automatically saves whatever 

changes you make.

• Maximum Folder Levels—Allows you to select how many folders the hierarchical playlist 

will display. Your choices are none, one, two, three or all. You can turn off the hierarchical 

display by selecting none.

ID3 TAGS

• Add Missing ID3 tags—For any MP3 file that does not have an ID3 tag, SoundJam can add 

one to the file.   The version that is used will be the one that is selected in the “Create ID3 

tags as” option.

• Update Existing ID3 Tags—When you type track names, album names, and other informa-

tion into your music files (using the File menu’s Get Info command), SoundJam ordinarily 

doesn’t make this information part of the MP3 files you create—instead, SoundJam stores 

this data as part of the file’s playlist window. In other words, it’s possible to wind up with two 
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independent sets of information about the album, artist, genre, and so on: the information 

that identifies the track in the playlist, and the ID3 tags that come built into the music files 

(see Chapter 4 for more on ID3 tags).

The Update Existing ID3 Tags option, when turned on, makes SoundJam change the existing 

track’s ID3 data (artist, album, genre, and other information) to reflect what you’ve typed in. 

(If Add Missing ID3 Tags is turned on, SoundJam adds such information as ID3 data even if 

the source material doesn’t have ID3 information to begin with.)

• Create ID3 tags as—This allows you to select which ID3 tag you would like to use. 1.0 and 

1.1 are the most widely used. 2.2 is rapidly becoming the standard but not all MP3 players 

understand tags of this version. 2.3 is the latest version, and it allows you to add the most 

information to a track.

• Create ID3 tags with Padding—Some MP3 players cannot correctly read files that were cre-

ated with padded ID3 tags. By disabling this option, SoundJam will create its ID3 tags with-

out the extra space. This means that if you make information in the tag larger (for example, 

changing the track name to a longer one) SoundJam may have to take a moment to grow 

your MP3 file slightly.

CD LOOKUP

The options on this panel pertain to SoundJam’s ability to retrieve information—song names, 

album, artist, and so on—from the Internet’s massive, collaborative music-CD information 

database, the CDDB Web page.

• CDDB Server—From this pop-up menu, choose the Internet CD server you’d like SoundJam 

to use when retrieving information from the Internet about your CDs. Click the Update 

Server List button to connect to the Internet and get an updated list of servers to use.

• Your E-mail Address—Type your e-mail address here, if it doesn’t already appear. The CDDB 

Internet database requires this information in exchange for the free CD information you’re 

looking up.

• Connect to CDDB Automatically—If this checkbox isn’t checked, SoundJam fills in the 

missing album and track information for your music CDs only when you click Get Names 

Online in the CD window, as described in Chapter 3. This option, however, makes SoundJam 

connect to the Internet CD database automatically whenever you insert a CD your Mac 

hasn’t seen before.

This option works best, of course, if you’re lucky enough to have a full-time Internet connec-

tion (such as an office ethernet connection, a cable modem, a DSL connection, or the like). 
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If you generally connect to the Internet using a standard phone-line modem, turn on this 

option only if you don’t mind SoundJam automatically dialing up your Internet account 

whenever you insert a new CD.

PLUG-INS

The Plug-ins panel offers a simple list of any visual plug-ins that are available to SoundJam. 

When you click a checkbox to turn it off, the corresponding plug-in no longer appears in the 

SoundJam Window menu.

At the bottom of the window there are two buttons, About and Configure, which may not be 

active for all plug-ins. When you select a plug-in which supports configuration, these buttons 

are available and allow you to configure the plug-in. Because each plug-in does something dif-

ferent, the results of clicking the Configure button will vary. Of the plug-ins that come with 

SoundJam, Melt-O-Rama is the only one that is configurable. Try highlighting the Melt-O-Rama 

plug-in in the list, clicking the Configure button, then experimenting with the resulting settings 

dialog box.

There’s little downside to leaving all of your original SoundJam plug-ins turned on and avail-

able. Plug-ins written by independent programmers that you download from the SoundJam 

Web site, however, may be a different story. Some may require a lot of memory to run—memory 

that you can reclaim by turning off these plug-in checkboxes. Others may not be visual plug-ins 

at all, but instead audio plug-ins that (for example) add reverb or some other effect to the music 

play-back. Turning off their checkboxes in this panel may be the only way you have to turn off 

such musical effects.

CONVERTER

The controls on this panel let you change the settings for SoundJam’s Converter window which 

turns CD tracks and other sound files into MP3, MP2, or AIFF files. See Chapter 4 for details on 

this process.

• Convert using—Use this pop-up menu to choose the file format you use most often: MP3, 

MP2 or AIFF. You’ll find a discussion of these three file formats in Chapter 4.

• Configure—Click this button to summon the SoundJam MP3 or MP2 Encoder dialog box, as 

described in Chapter 4. The identical dialog box appears here so that you can specify your 

most frequently used settings, thus establishing new factory defaults, saving you the trouble 

of setting them up every time you perform a conversion.
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• Select Conversion Destination—When SoundJam has finished creating a new MP3, MP2, or 

AIFF file, where should it put the file? Click this button to designate a new folder as these 

files’ birthplace. (If you don’t specify a location, SoundJam puts them into a Music folder 

inside the SoundJam folder.)

ADVANCED

The Advanced panel is for SoundJam’s specialized or technical settings.

• Add Encoded/Opened Files To—These options let you control which playlist should receive 

newly encoded or opened files. You can choose None to let SoundJam keep track of the files 

internally while you are playing them (on a temporary and hidden playlist). Other options 

include the Master Playlist or a new playlist. By default, SoundJam wants to put all new 

tracks into the Master Playlist for convenient access.

• Disk for Scratch Files—When you extract the sound from a CD or QuickTime movie, or 

when you convert sound files into MP3, MP2, or AIFF formats, SoundJam occasionally cre-

ates temporary files on your hard drive, which it then deletes when it’s finished with the 

work. This pop-up menu lets you specify which volume (hard drive, Zip, or other disk) you 

want SoundJam to use for storing these temporary files. You’ll find this option most useful 

when SoundJam gives you a “not enough disk space available” message.

• Buffer Sizes—These options let you change the internal buffer sizes used for streams and 

files. Increasing the buffer size used for streams may help poor network connections keep 

up with playback.

CONTROLS MENU

This menu contains commands for Play, Stop, Next Track, and other typical CD player-type controls. 

Of course, most of these commands are also represented by buttons in the Player window, and are 

described in Chapter 1. The advantage of this menu, however, is that it indicates the keyboard short-

cuts for each of these commands, which lets you manipulate SoundJam without having to use the 

mouse. You’ll also find the menu command for the Karaoke feature, as described in Chapter 2.

✎    Tip: The Controls menu also contains a Mute command, which can be useful when, for example, the tele-

phone rings while you’re playing music. You can also tap the Space bar, which toggles between Play and 
Pause.
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SKIN MENU

This menu displays one listing of each skin file in the Skins folder of your SoundJam folder. (A skin is a 

graphic design scheme for the Player window. See Chapter 2 for a complete discussion of skins and 

how to install and use them.) If you have custom skins in your Skins folder, you’ll also find a Random 

Skin command here, which makes SoundJam show a different skin each time you launch the program, 

and a command called Built-in, which shows the original, factory-installed skin.

WEB MENU

If your Mac can connect to the Internet, you’ll find the commands in this menu useful indeed. They 

launch your Web browser and open up the corresponding Web sites automatically—which is a great 

way to get more skins, more visual plug-ins, and more music files for use in SoundJam.

You can also use the Update SoundJam™ MP command to make sure that you’re using the latest and 

greatest version of the program, and the Get Skins command to jump directly to the skins page at 

www.soundjam.com.

WINDOW MENU

Use this menu to open SoundJam’s various windows. They include:

PLAYER

This window is the control panel for your virtual CD player, as described in Chapter 2. It contains but-

tons for starting and stopping the music playback, along with volume and balance knobs, the Shuffle 

and Repeat controls, and a counter.

EQUALIZER

Choose this command to open SoundJam’s ten-band Graphic Equalizer window, which lets you shape 

the music—bass, treble, and everything between—to suit your taste and your equipment. See Chapter 

2 for instructions.

CONVERTER

This command opens the Converter window, which lets you turn CD tracks and other common music 

files into MP3 or AIFF files. Chapter 4 contains step-by-step instructions.

MASTER PLAYLIST

In addition to any playlists you create yourself, as described in Chapter 3, SoundJam always maintains 

one permanent playlist called the Master Playlist. This command opens the Master Playlist window. 

(Unlike normal playlists, the Master is always open. Clicking its close box just hides the Master Playlist 

instead of actually closing it.)
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ALARM CLOCK/SLEEP TIMER

This command opens the Alarm Clock and Sleep Timer window. See Chapter 2 for details on using this 

window.

[PORTABLE MP3 PLAYER WINDOWS]
Any audio player device that you have attached to your Macintosh through the USB port will be listed 

here.  Some devices that you may see here are the Rio 500 and the Nomad II.

[CD AND PLAYLIST NAMES]
The Window menu also lists any playlist windows and CD windows that are currently open. By choos-

ing their names, you bring the corresponding windows to the front.

[VISUAL PLUG-INS]
Any visual plug-ins you have open and active will appear here. Select the name of a plug-in to bring its 

window to the front.

USE FULL SCREEN

This will display your frontmost visual plug-in using the whole screen. To exit full-screen mode, sim-

ply press the Esc (escape), or Command-F keys.

SCRIPTS MENU

If you have downloaded or created AppleScripts to extend or automate SoundJam, put them in the 

Scripts folder inside of the SoundJam folder. The scripts will appear in the Scripts menu, ready for use.

HELP MENU

Choose SoundJam™ MP Help from this menu to view a text-only, abbreviated version of this manual. 

This menu also contains the usual Macintosh help commands, such as Show Balloons.
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GETTING IN TOUCH WITH CASADY & GREENE

HAVE YOUR TECHNICAL INFORMATION READY

If you need to get in touch with our tech-support staff, please be ready to give us the following infor-
mation:

1. Your SoundJam MP version and serial number.

2. A description of your system configuration, including…

• Macintosh System Manufacturer and Model

• System RAM

• System Software Version

• Startup files in use on your system

3. A detailed description of your problem including where and when it happens.

We’ll probably be able to give you the most help if you’re sitting in front of your computer and can take 
some time to work with us in solving your problem.

TECHNICAL SUPPORT CONTACTS

Technical support is available any time via the Internet.

On-line Support:
Message Board . . . . . . . . . . . . . . . . . . . . . . . . . . . . www.casadyg.com/support/msgboard/
FAQ . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . www.casadyg.com/support/faq/
World Wide Web . . . . . . . . . . . . . . . . . . . . . . . . . . . www.casadyg.com
FTP Site  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ftp.casadyg.com

Internet E-Mail:
Sales and Upgrades . . . . . . . . . . . . . . . . . . . . . . . . sales@casadyg.com
Suggestions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . c&g@casadyg.com
Web Site Comments and Suggestions . . . . . . . . webmaster@casadyg.com

We are also available by phone Monday–Friday from 8:30am–4:30pm PST.

Casady & Greene Live Technical Support  . . . . . . . . . 831-484-9228
Casady & Greene 24-hour FAX . . . . . . . . . . . . . . . . . . . 831-484-9218

Or you can write us at: 
Casady & Greene, Inc., 22734 Portola Drive, Salinas, CA 93908.





SOUNDJAM MP PLUS INDEX 67
Numerics

7-day demo 3

A

about SoundJam 51
add ID3 information tags 41
advanced encoding 40
AIFF files 35, 37

encoder 36
alarm clock/sleep timer 19, 63
album name 14
animations 11
apple menu 51
artist 14
audio input 25

B

balance control 10
bass/treble sliders 9
bit rate 38
building your music collection 23

C

CD
and playlist names 63
discs 24
driver software 43
files 25
indicator 11
joining tracks 53
playing discs 8
sending information to CDDB 34
track information 54
tracks 35
window 14

CD remote programs 31
CD remote programs plus 31
CDDB 2, 30, 41, 54, 59

sending information to 34

channels 39
close box 8
close window 52
columns 15

adding 17
location 17
managing 17
sample rate 17
sorting 15
track 17
year 17

comparison of MP3, MP2, AIFF 37
compose playlist 51
configure button 38, 41
connecting your Mac 

to your stereo 17
controls menu 61
conversion process 36, 42
convert ID3 tags 52
convert using pop-up menu 36
converter window 36, 42
converting

files 42
select conversion destination 43
settings 36

counter 9
Creative Labs 45

D

Diamond Multimedia 45
download track information 31
downloading music 23

E

edit menu 53
CD info 54
get info from CDDB 54
join CD tracks 53
preferences 54
send info to CDDB 54

undo, cut, copy, paste, clear, 
select all 53

eject button 10
e-jukebox 7
embedded information 14
encoding

configure button 38, 41
MP2 files 41
MP3 files 38

equalizer 8, 12
auto 13
close box 12
eq presets pop-up menu 13
equalizer bands 12
on/off 12
preamp 13
reset 13

export 53
eye candy 20

F

faq support 65
fast forward button 11
file menu 51

close window 52
compose playlist 51
convert ID3 tags 52
export 53
get info 52
new playlist 51
open 51
open playlist 51
open URL 52
play from sound input 52
quit 53
record from sound input 52
save, save as, copy as 53
show original 52

filter frequencies below 10 Hz 40



SOUNDJAM MP PLUS INDEX 68
G

G4 processor 43
get info 52
get info from CDDB 54
get track names online 31
graphic equalizer. See equalizer
graphic spectrum display 10

H

help menu 63

I

ID3 tags 41, 52
convert 52

I-Jam 45
MultiMediaCard 50
optimal bit rate for MP3s 38
USB card reader 50
working with 50

I-JAM Multimedia 45
installing SoundJam 2
internet

downloading music 23
Internet CD database 30
internet e-mail support 65

J

join CD tracks 53

K

karaoke mode 18
kbps 38
kHz 39

M

melt-o-rama 60
menu by menu 51
message board support 65
min/max box 9
MOD files 35
mono files 39
MP2 files 37

encoder 36
encoding 41

MP3 files 37
convertible sound files 35
encoder 36
encoding 38
making 35
what are they? 1

MP3 indicator 11
MP3 portable players 45
MPEG file options 41
MultiMediaCard 50
music

building & organizing 
collections 23

downloading off internet 23
finding 23
from any audio source 25
from other sound files 25
from your CD discs 24
from your own CD files 25
on SoundJam CD 23
SoundJam’s web menu 23
streaming 23

music files
opening 7

music folder 43
music from songs.com 23

N

net indicator 11
new playlist 51
Nomad II 45

DOS-compatible filenames 49
optimal bit rate for MP3s 38
SmartMedia card 48
working with 48

O

on-line support 65
open 51
open a music file 7
open playlist 51
open URL 52
options button 11
organizing your music 23, 26

P

patch cord, included in 
physical product 17

pause button 11
performance 39
play from sound input 52
play/stop buttons 10
player window 8

animations 11
balance control 10
bass/treble sliders 9
close box 8
counter 9
eject button 10
equalizer button 8
fast forward button 11
graphic spectrum display 10
min/max box 9
MP3, CD, Net indicators 11
options button 11
pause button 11
play/stop buttons 10



SOUNDJAM MP PLUS INDEX 69
playlist button 9
position bar 8
read out 10
repeat button 9
rewind button 11
shuffle button 10
song information 8
stereo/mono indicator 11
volume slider 10

playing CDs 8
playlist composer 28

open 51
playlist window 14

columns 15
sorting 15

where does SoundJam 
get its info? 14

playlists 9
building 28
compose 51
composing 28
exporting 30
new 51
open 51
organizing 26
working with 27

plug-ins
visual 20

adding 20
opening 20

portable MP3 player windows 63
portable music players 45
position bar 8
Power PC G4 with 

Velocity Engine 43
preferences 54

advanced 61
CD lookup 59
converter 60
files 57
general 54
ID3 tags 58

player 56
playlists 58
plug-ins 60

Q

quick start 5
QuickTime movie sound tracks 35

R

RCA jacks 18, 26
read out 10
record from sound input 52
recording 26
register online 51
repeat 9
rewind button 11
Rio 500 45

optimal bit rate for MP3s 38
working with 45

S

sample rate 39
scripts menu 63
selecting sound files to convert 35
send info to CDDB 54
serial number 3
show original 52
shuffle 10
skin menu 62
skins

button function change 
depending on skin 10

converting 22
downloading 22
switching 21

sleep timer 19
smart frequency reduction 40
SmartMedia card 48
snd files 35
song information 8

song name 14
songs.com 23
sorting

by album 15
by artist 15
by bit rate 15
by conversion order 15
by date 15
by genre 15
by kind 15
by name 15
by play order 15
by shuffle order 15
by size 15
by time 16
copy to play order 16

sound files 25
sound input

play from 52
record from 52

SoundJam
about 51
edit menu 53
installing 2
menu by menu 51
register online 51
serial number 3
setup assistant 51
system requirements 5
test drive 5
welcome to 1
what does it do? 7
what is it? 1

stereo files 39
stereo mode 40
stereo, connecting your Mac to 17
stereo/mono indicator 11
streaming 23, 52
system requirements 5

portable players 45



SOUNDJAM MP PLUS INDEX 70
T

technical support 65
track information 14
track names 14

adding information manually 32
adding information manually 

with get info 32
changing information on 

multiple tracks 33
downloading information 30, 41

tutorial 5

U

use full screen 63

V

variable bit rate encoding 39
VBR 39
Velocity Engine 43
visual plug-ins 20, 63

melt-o-rama 60
use full screen 63

volume slider 10

W

WAV files 35
web database 14
web menu 62
window menu 62

alarm clock/sleep timer 63
CD and playlist names 63
converter 62
equalizer 62
master playlist 62
player 62
portable MP3 player window 63
use full screen 63
visual plug-ins 63



MORE SOFTWARE TITLES FROM CASADY & GREENE 71
MORE SOFTWARE TITLES FROM CASADY & GREENE

CONFLICT CATCHER™ 8
Stop crashes and freezes! Iso-

late the file which is responsi-

ble for a problem you are 

experiencing! Manage your 

files and extensions! Conflict 

Catcher’s new Main Window 

includes all the information 

about your files you’ll ever need. Smoothly upgrade 

to upcoming Macintosh operating systems. Merge 

your previous system folder into a clean system 

folder—saving hours or even days of laborious 

work. 

MAC Requirements: Macintosh computer with a 

CD-ROM drive running Mac OS 7.5-9. Does not 

work on Macintosh Plus, SE series, Classic series, 

or Powerbook 100.

INFOGENIE™ 2
InfoGenie 2 will automatically 

save the URL, title and text of 

any web page for you in a data-

file. With a click, launch that 

saved page any time you need 

it. Use it for any information 

you need to save and find again 

fast. Search on single or multiple word strings. 

Import/Export to a wide variety of file formats, 

including tab-delimited and e-mail text files!

MAC Requirements: System 7.0 or greater, 1.2M 

RAM, System 7.6 Savvy and Power Mac Native.

GRAMMARIAN™ 2
Good grammar is good com-

munication! Grammarian 

checks interactively or by 

batch in all your text programs, 

including e-mail, word pro-

cessing, database, spread-

sheet and more. It includes our 

intelligent Thematic Relations Technology to make 

in-context suggestions to improve your writing. 

Offers 150 writing rules—more than any other inte-

grated grammar checker—making your ideas clear 

and easy to understand.

MAC Requirements: Mac OS 8.1 or later.

SOUNDJAM™ MP PLUS

Put all your music into a juke-

box collection on your Mac! 

Converts music quickly 

between high quality MP3, 

CDs, AIFF, WAV, QuickTime, 

and other formats. It com-

presses your music to a frac-

tion of its size while maintaining near CD quality. 

Organize your music by artist, track, song, and 

music style. Listen to music, and more, over the 

internet without waiting for downloads.

MAC Requirements: Mac OS 7.6.1 or later, Power 

Macintosh with a 603 processor at 100 mHz, G3/G4 

processor recommended. CD-ROM Drive.
You may purchase and get more information about our products by phone, fax, internet, or e-mail!

Sales: 831.484.9228 or 800.359.4920 • FAX: 831.484.9218

Web Site: www.casadyg.com • E-mail: c&g@casadyg.com
MacBundle

www.macbundle.com
WinBundle

www.winbundle.com
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SPELL CATCHER™ 8 MAC

It’s Universal—works in all 

programs, utilizing a single set 

of reference files. It’s compre-

hensive—one of the largest 

integrated spell checking, the-

saurus, and definitions dictio-

naries available. It’s multi-

lingual—9 different language spelling dictionaries 

with additional spelling dictionaries available 

upon request. Import customized words from 

other programs. Use our Speak feature to hear the 

word pronounced with your Mac’s voice.

MAC Requirements: System 8.1 or later and a CD-

ROM Drive.

SPELL CATCHER™ PLUS

Works universally—in e-mail, 

the Internet, word-process-

ing—wherever you are, Spell 

Catcher can help! Batch check 

an entire document or use 

Interactive checking that 

watches while you type. Add 

the versatility of multi-lingual spelling dictionaries 

for French, Canadian French, German, Swiss Ger-

man, Swedish, Spanish, and Italian, along with our 

extensive US English and UK English dictionaries. 

Access powerful supplemental resources including: 

medical, legal, scientific/technical, computer 

terms, biological/geological, HTML, and more!

PC Requirements: Windows 2000, 98, 95, NT. CD-

ROM Drive.

SPEED STARTUP™
Over the last 15 years, Macin-

tosh speeds, CD-ROM speeds, 

modem speeds have 

increased, while startup 

speeds have slowed. All that 

extension-loading, memory-

checking, and Finder-launch-

ing ties up even the most powerful Mac for a 

minute or more, every time you turn it on, every 

day of your life. Speed Startup saves you time…It 

lets your Mac start up faster. The more memory 

and startup files you have, the more time you will 

save. Just install Speed Startup. You don't have to 

learn or configure anything!

MAC Requirements: Any Mac running Mac OS 

7.5.5 and later including Mac OS 8.0-8.6.

AMOEBARENA™
In the year 2309, war has been 

reduced to a microscopic 

dimension! Battling galaxy fac-

tions are represented on this 

CD ROM computer board 

game by four unique types of 

single-celled organisms. Holy 

bacteria! Players try to second-guess opponents’ 

moves…and what weird opponents at that—meet 

Belchasourus Rex, Lord Hogg, and Slorgakk, to 

name a few. To the victor go entire chunks of gal-

axy!

MAC Requirements: Any Macintosh with 256 col-

ors, or 16 levels of grayscale, 8MB RAM, System 7, 

and a CD-ROM drive.
You may purchase and get more information about our products by phone, fax, internet, or e-mail!

Sales: 831.484.9228 or 800.359.4920 • FAX: 831.484.9218

Web Site: www.casadyg.com • E-mail: c&g@casadyg.com
MacBundle
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WinBundle

www.winbundle.com



MORE SOFTWARE TITLES FROM CASADY & GREENE 73
FUN BUNDLE™ II
Whether you want Zone War-

rior’s white-knuckle adventure 

at the rim of the galaxy, Glider 

Pro CD’s wild paper airplane 

rides, Crystal Crazy’s daring 

and enterprising space cow, or 

Step On It!’s toychests gone 

wacko—they're all here—the best games to ever 

emerge from the Casady & Greene workshop! Put 

the entertainment back into your computer!

MAC Requirements: System 7, Mac OS 8, or higher. 

CD-ROM Drive. Power Macintosh required for 

Zone Warrior.

ORIGAMI: THE SECRET LIFE 
OF PAPER™ HYBRID CD
Learn the art of Origami paper 

folding—Secrets of this thou-

sand-year-old technique await 

you! Create the crane, gyro-

scope, frog, iris, and more. 

Includes free Origami paper to 

get you started; you can even learn how to make 

your own Origami paper! Tour the gallery where 

creations of many of the world’s greatest Origami 

masters are displayed! Over 100 full motion videos 

and 300 color photos! 

MAC Requirements: Macintosh with 8MB RAM 

running Mac OS 7 or 8, 13” monitor at 640x480, 

Mac LCIII, Power Mac Native, 2x CD-ROM.

PC Requirements: Windows® 3.x, or ‘95 (won’t run 

on Windows NT®), 486 processor, with 8MB RAM, 

256 colors, 2x CD-ROM.
You may purchase and get more information about our products by phone, fax, internet, or e-mail!

Sales: 831.484.9228 or 800.359.4920 • FAX: 831.484.9218

Web Site: www.casadyg.com • E-mail: c&g@casadyg.com
MacBundle
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